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Learning Maxsurf

Welcome to Learning Maxsurf. This introductory training manual will give new
users to Maxsurf a thorough understanding of the application’s architecture,
main functions and give an idea of its capabilities. Experienced users will also
find this manual useful to expand their understanding of concepts or simply as a
refresher.

This training manual is by no means an extensive guide to using Maxsurf. If you
need help or would like more information on certain topics, the manual should
be consulted. The training manual consists of several short tutorials, each with
their own concrete learning goal. Throughout the tutorials, the user will model a
simple hullshape and make modifications to it. Each tutorial may have different
related resources such as:

1. Sample designs. Some tutorials will have a “start” and “end” sample
design attached to it. For example: BasicFairing_start.msd and
BasicFairing_end.msd. All these designs can be found in the c:\program
files\Maxsurf\Training Samples directory.

2. % Explanations of background theory. It is recommended to read these
sections.

3. # Videos. There are several short videos you can watch that illustrate
the steps explained in the tutorial.

a. [Web] You can click on this link for each video to view the
video online; i.e. on the internet. This will open up the video in
your Internet browser. You do need a reasonably fast internet
connection for this.

b. [Disk] Click on this link from your PDF document when you are
running this training manual from your local computer. This will
start up the video from your local hard drive. This is generally
much faster than viewing the videos online, but it does require
that you have installed the MSLearning installer. Links to
“[Disk]” only work from the PDF document and not from your
internet browser.

4. Links to the User Manual for background reading on concepts, or further
explanation of dialogs and related commands.

Tips on using this training material:
e Take your time and read all instructions carefully

e Read explanations, try to understand the concepts explained

Start the training by reading “Chapter 1 Maxsurf Help”.



http://www.fdsfiles.com/training/learningmaxsurf/MSLearning.exe




Chapter 1 Maxsurf Help

Before you can start learning how to use the program, it is important that you
learn what to do when you want more information on using particular commands
or you need help with a particular feature. Every command in the Maxsurf
applications is thoroughly documented in the User Manual. This section of the
training manual describes how to open the manual and find what you are looking
for.

Opening the Manual

You can access the manual from different locations:
1. From the Windows Start Menu: Programs | Maxsurf | Help
2. From within the application in the Help menu
3. From within the application by pressing the F1 function key.

Note

In this Training Manual, a vertical bar ¢|” will be used to separate
menu titles, sub-menu titles and commands in specifying the
location of a command from a menu. For example, Help | Maxsurf
Help indicates that Maxsurf Help can be accessed from the Help
Menu.

Many commands can be accessed from toolbars and via keyboard
shortcuts (specified in the menus); however in this manual, access
to commands will be described through navigation of the menus.

You will need Adobe PDF reader to open the manuals.

Finding a Topic

If you have opened the Maxsurf User Manual PDF file, you can search for a key
word or phrase by clicking on Search from the Edit menu, and following the
instructions in the Search PDF pane.

You can also use this toolbar button: - ** =™ or Ctrl+Shft+F.

Other Resources

The manual is also available in Adobe Acrobat (PDF) format from the Formation
Design Systems Support Centre at www.formsys.com/support.

The Support Centre also offers a Knowledgebase which includes Frequently
Asked Questions and Tips and Tricks databases.

Continue with the Chapter 2 Starting Maxsurf section on the next page.

11


http://www.adobe.com/
http://www.formsys.com/support




Chapter 2 Starting Maxsurf

If you have not already done so,

> Install Maxsurf by inserting the CD and running the Setup
program, and then follow the instructions on screen.

» Launch the Maxsurf application on your computer from the strart
menu.

You should see something like this:

Ele ESt Wew Mabers ook Sufaces  Deplyy  Dafs  Window  belp

=" RS T. A .l

aF<1ir-&. HHEDB : i
| st Bl e peripmctie . [ I50%| | Pxslie
£ Dua=gn

U Bedy Plan

Farm Druf it

Trps E-Splne

L Hull Shall
=] i £} Hamne Anpamnily Tyt W Rives Cln Lo, 5HiT.

Lirgibuschnal 5 M)

Transeerss 3 [Fleacbler)
A ] -

il £ >

Fady R

If you see something completely different:

> Close the application and start it again, this time while holding
down the Shift key.

This will bring up the following dialog:

Hydrestatic - -
atrength, damsged stability and
resistance prediction.

CONSTRUCTION

Stiffener paths, frame generation,
plate development & parts datahase

> Clear all Maxsurf Preferences

Before you can do anything in the application, you either have to start a new
design or open an existing design.
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Continue reading the Opening a Design section.

Opening a Design

Opening a Design - Concepts

A Maxsurf file has a .msd file extension and can be recognised by the B file
icon. As in most Microsoft Windows applications, you can open files in different
ways. For example, you can open files by double clicking on them or by using a
File | Open menu. Let’s have a look at the different ways you can open a file in
Maxsurf.

Opening a Design — Video

#= Watch a short video that shows you how to open a design in Maxsurf using
the File | Open method and the drag and drop method. [Web | Disk]

Opening a Design — Procedures - File | Open

File | Open
Probably one of the most conventional ways to open a file is by:

» Start the Maxsurf application
> Click File | Open Design
» Navigate to the Maxsurf program file directory.
This is C:\Program Files\Maxsurf, unless you have specified it differently.
» Open the Sample Designs folder

Gpen B
Lok, in: |_;' Sample Designs j & I‘ji ER-
A (CIFerties
) [Earulihls
My Recent () Maval
Diaeu s () Poweryachts
T | Sailing¥achts
[ 5hips

Desktop ) Warkboats

Hullspeed Sample_workboat, rmsd
Hvdromax Sample_workboat, rmsd
Maxsurf Sample_Trawler,msd
Seakeeper Sample.msd
Span Sample_IMSYacht,msd
Workshop Sarnple_Workbaoat.msd

\$

iy Documents

@

My Carputer

-
My Network File narme: |Ma:-:surf Sample_Trawler. msd j Open |
Places
Files of bype: | b ameuf Design Files [*.med] j Cancel

» Select the design called Maxsurf Sample_Trawler.msd and open
it.

—

Done! The design will initially be displayed in each of the four view windows by
the outline of its surface edges (in the case of the Sample Trawler, there is only
one surface), represented as solid grey lines.
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All Maxsurf applications have the ability to open different sets of
data. For example in Maxsurf you can load Markers or surface
models. The type of data that can be opened is determined by the
Window that you have currently got “active” or “frontmost”. You
will learn about the different Maxsurf Windows later.

Opening a Design — Procedures - Double Click

Double Clicking on a File

> In Windows explorer, navigate to
c:\program files\Maxsurf\Sample Designs

» Double click on the file called Maxsurf Sample_Trawler.msd

This will start up a new Maxsurf application and bring up the following dialog
first:

Please locate the materials and shapes library:

Lok, in: |_;' [EERET j &5 B
1 |3 Aukomnation Samples
L\ﬁ () Cales

My Recent L2 Dangle
Documents | o eriteriaHelp

F'@ [y HMSpecificCriteria
[ILibraries
Deskiop [C)Reference Designs
) Sample Designs

J ) Sample Modeling Features
|2 Training Samples

) kilities
- Workshaop Library wsl
58
My Computer
J
by Hetwork File narme: |W'orksho|:| Library. wzl j Open

Places

Files of type: |Materials Librany Files [ ws) j Cancel

> You can select the Workshop Library.wsl or hit Escape to skip
this step.

The Workshop Library is only used in case you wish to allocate material
properties (eg. material and thickness) to a surface in Maxsurf and will not be
needed during the LearningMaxsurf training.

Opening a Design — Procedures — Drag and Drop

Drag and Drop

One of the less known options is that you can actually drag a .msd file onto any
of the View windows of the Maxsurf application.

» Close all applications you may have open on your computer, so
that you don’t get confused with the next few steps.

> Start Maxsurf

» In Windows explorer, navigate to
c:\program files\Maxsurf\Sample Designs

15



» Hold down the left mouse button after clicking on the Maxsurf
Sample_Trawler.msd once.

» Now drag and drop the file into any of the View windows in
Maxsurf:

FH Maxsurf Professional -

| Fle Edt Wiew Msrkers Controls  Sufaces Display Data window Help
d & Sample Designs BEEE = ‘@ & ‘ FE I T B I e sy
| Fle Edt view Favortes Tools  Help aw

: - 6 ( = -
rE e Back - () Lj; p Search || Folders

i Address ‘@ CilProgram Files\Maxsurf|Sample Designs

A Mame -
File and Folder Tasks # () 5ailingvachts

=) Rename this il aships

" o I workboats
(B¢ Move this file B Hullspeed Sample_Workbaat.hsd

() Copy this file [BiElHullspeed Sample_workbost.msd
€ Publish ths file bo the 4] Hydromax Sample_IMGeriteria.her
\sh Hydromax Sample_wWarkbaoat, hmd
() E-mail this file Bty croman Sample_workboat, msd Zi|Eody Plan o|x|
3¢ Delste this il MaxsutF Sample_Trawler.msd
BapFrefit Sample_Patrolvessel,pfd
[iE]scakeeper Sample.msd
QOther Places Seakeeper Sample.skd
Fo—p 5pan Sample_IMSVacht. msd
=] Span Sample_IMSYacht, spd
My Documents

& My Computer
Type: MSD File Date Modified: 3/05/2006 1:37 PM Size: 11 13.0 KB 'J My Computer

Bl\wicrkhon Samnle Sinrkhnat med
<

Ed Markers [5][B][*] EiSurfaces  [FIEI®]| EilCurveof ... [£][E]*]
pescy L

Dragging and dropping the file from Windows explorer window into one of Maxsurf’s View windows.

Continue with the section on Closing a Maxsurf Design.

Closing a Maxsurf Design

You can close a design from the File menu:
> File | Close Design

In case there have been any changes to the model since you have last saved it,
Maxsurf will ask you whether you wish to save the design changes.

\ ? ) Sawe Design Changes?

es Mo | Cancel |

e Selecting yes will save the changes and close the model.

e Selecting no will not save your changes and close the design. You will lose
all changes since the last save.

e Selecting cancel will cancel the close design command and allow you to
continue working.

Continue with the Chapter 3 User Interface section on the next page.
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Chapter 3 User Interface

In this training manual it is assumed that the user has a reasonable familiarity
with working in applications on any Microsoft Windows® operating system.
Some Maxsurf specifics to the User Interface are described below. It is a good
idea to read this section before you start modelling, as it will give you a good
understanding of the architecture of the application which helps you find
commands faster and operate the program more efficiently.

% The User Interface can be defined as the aggregate of tools available that
allow you to work with the application. Some of these tools can be used for
viewing while others allow you to control or manipulate the object being viewed.

The Maxsurf User Interface can be divided up into three main groups:
e Menus
e Toolbars

e Windows

Menus

Unlike some other CAD applications Maxsurf does not have a command line.
This has the advantage that you don’t have to memorise different commands and
everything can be done using the commands in the menus.

To enable faster access to the menu commands Maxsurf has two other options:

1. Toolbars. The most common commands can also be accessed through
toolbars.

2. Additionally, Maxsurf has several object based right click commands.
This means that after selecting an object and using the right mouse
button, Maxsurf displays the most commonly used commands on the
selected object. For example, when you select an edge of a surface and
right click on it, you can access the Surface Properties or perform a
trimming operation on the surface.

These are just other (usually more efficient) ways to get to a corresponding menu
command.

The menus and toolbars in Maxsurf operate in the same way as most Microsoft
applications and will not be explained any further. At this stage it is not required
to know all the menu commands as we will cover most of them as we go along in
this training manual, but for the interested reader the function of each Menu
command is explained in detail in the Menus section of the Reference Chapter of
the Maxsurf manual.

A brief overview of the menus is worth studying:

Menu Description

File Working with the file

Edit Copy & Paste and other editing commands

View Lets you set how you want something displayed. Often
confused with the Display menu.

Markers All commands to do with Markers

Controls All commands to do with Control Points
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Curves All commands to do with Curves

Surfaces All commands to do with Surfaces

Display Select what you want to display

Data All commands to do with calculations & producing data
Window Different window display options

Help Accessing different Help resources

Toolbars

The toolbars contain toolbar buttons that activate menu commands. Only the
most commonly used menu commands are on the default toolbars. Maxsurf
allows you to create you own toolbars and toolbar buttons. This is not covered in
the LearningMaxsurf training manual. For the interested reader: information on
this can be found in the Customising Toolbars section in the Maxsurf Reference
chapter.

Windows

Continue reading the Maxsurf Windows section of this training manual.

Maxsurf Windows

Maxsurf consists of a total of 10 windows. Each window has its own
functionality and usefulness depending on the task that you want to perform.
You will rarely need all 10 windows at the same time. For example: when you
are working with Offsets or when you are modelling, there is little need for the
Calculations window. The Calculations window can then be minimised or closed
to optimise available screen space.

Within the 10 Maxsurf windows we can identify a group of 4 “View Windows”
that are used to view the model.

Continue reading the 3D Modelling in 4 View Windows section.

3D Modelling in 4 View Windows

% One of the most difficult things to learn is working in a 3 Dimensional
environment on a computer screen. Especially if you have never used 3D
drafting tools before it can take some time to get used to. The Maxsurf
application is specially designed to help you manipulate a shape in 3D using just
your mouse and the computer screen display. The tutorials in this document will
teach you different mouse techniques and screen display settings that increase
your 3D modelling efficiency in Maxsurf.

Maxsurf consists of four view windows. For each 2D view direction, Maxsurf
has one window:

View direction View Window
Looking from the stern to the bow Body Plan Window
Looking from the Starboard side Profile Window
Looking from below* Plan Window
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* This may appear odd, but this way the user can model above the centreline in Plan view. Research
has shown that a naval architect can interpret the shape of a vessel in plan view better when it is
drawn above the centreline.

4 Body Plan

— =
777 W

—
‘LI\ OO OO OO0

+ 12.591 3124 ¥y 331.6° e 3077

Body Plan Window
EA Profile BEE&®

I T ==y

++ 2253 $ 5137 ¥y 338.4° o 9.842

Profile Window

CRaa o LIEI

Plan Window

Finally Maxsurf has a 3D viewing window that allows you to view the model in
3D, rotate it and render it. This is called the Perspective Window.

[ Perspective BBE&E

T T TR TS

LA L I S S By N L S N B ) S L I
-a0 I]\'Hl 0 180

Perspective Window

Continue with the section on Working in Different Windows Layouts.

Working in Different Windows Layouts

Window Layouts - Concepts

% Most computers use a 1024 x 768 resolution monitor which means that there
is limited space available and you continuously have to find a compromise
between the number of windows you have open and the size of the windows:
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5 windows open, but each of them is quite small.
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Only one window open (Body plan), but now you can’t see the effect of a
modification to the shape of the design in the Profile, Plan or Perspective window.

It is really a matter of experience and personal preference what suits your
working methods best. Here are some tips from the Maxsurf developers:

Window layout tips:

- To maximise screen space, it is recommended to maximise the
Maxsurf application window at all times.

- When modelling, close all windows except for the view windows.

- When modelling, switch between working with 4 view windows
and just one view window.

- Minimising the amount of information on your screen helps you
work more efficiently.

Windows Layout — Video

# View a video that shows you the different windows layouts in Maxsurf as
well as different ways to switch between windows (next section). [Web | Disk]

Windows Layout — Procedures

In the following steps you will learn how to setup your windows layout in
Maxsurf so that you have just the 4 view windows open.

> Start Maxsurf while holding down the Shift key
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TrainingVideos/WindowLayoutP.avi

> Select “yes” to clear all preferences

This will start Maxsurf with the default windows settings:
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> Use Window | Tile Horizontal

You’ll see something like this:
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Maxsurf windows after Tile Horizontal

» Now close all windows except for Body Plan, Profile, Plan and

Perspective
£ LU ¥

Surfaces E]@

|~
-

[ m[ —
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Notice how the closed windows are all stacked at the bottom of the Maxsurf
application window:

Ed Surfaces  [#][0][*] EX Curve of ... [#][0][*]| EH Offsets [= ][]

Ed Control P... E]E]E] EH Calculations E]E]E] B Markers E]E]E]
[ M|

> Do another Window | Tile Horizontal
You should now see something like this:
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You can re-open any of the closed windows by simply selecting the window
from the Window menu and the selected window will restore to its original
position and size before it was closed.

Continue with the Switching Between Windows section.

Switching Between Windows

Switching between windows — Concepts

aA Window can be either in the background (passive/display only) or it can
be the “current window”. A background window is a passive window used for
display only and you can not type or modify any of the objects in it. Only one
window can be the current window or active window. In this active window
objects can be modified (eg. change surface shape or text in a table).

You may click within any window to make it the active window. If you have
several windows open, you can recognise the active window by the brighter
colour of the title bar. A window may also be brought to the top by selecting its
name from the Windows menu.

Switching between windows — Procedures

> Start Maxsurf while holding down the shift key
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» Click yes to clear all saved Preferences
In the images below the Maxsurf Sample_Trawler design is used.

i1 Maxsurf Profescional - C:Wrogram Files\MaxsurfiGample DesignsWassurf Sample_Trawler.msd [T B
Ele Edt  Yiew [Markers Conbrols  Jrfeces  [wplsy Data  Windoew  Help

GH | BR3P, aqe+dRh. DO I FE . &
eFHMars EEEE *REFE|E * aoe|EFloa
Asgembly X .

= -2 Desgn
o i Hul

EIEE| | i Bedy Plan

i Program Fles Mo FiSampls DesgneHacsurf Sampls_Trawler, ms

> Maximise the perspective window by clicking the & putton in the
top right corner of the window.
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- 180 I 0 I I:IYﬂ_I i) l 1E:I|

= |[2]x] [E]
This will maximise the Perspective window inside the Maxsurf application
window:

Ef|Maxsurf Professional - [Perspective] EEE
File Edit Wew Markers Controls Surfaces Display Data  Window  Help -3 X
DEHsRR(&(?. /e QSR i0 T([WRiLTis
oFHarys NEEEzmmnel [SeeEF] 2
-18] 180
-0 \ _%]
. %
] -
] I
1) e
P T U R
|C:'|,Pr0gram FilesiMaxsurfiSample DesignsiMaxsu /4
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Perspective window maximised inside the Maxsurf application window.

Note: When a particular window is maximised, the program’s title bar reflects
which window is being displayed: £ Maxsurf Professional - [Perspective]
» Now select Window | Profile

This switched to the Profile window. Notice how the Window toolbar has
updated from:

EEEE 7 5 EEEE >

» Now Click on the Restore window button in the top right of the
Maxsurf application window;

This restored the Profile window to its previous size and location.

You can also switch between the design view windows by using the

Window toolbar: |E| = |

Continue with the Assembly Pane section.

Assembly Pane

The Assembly Pane is a special case and deserves an extra explanation when

discussing windows layouts. When used properly, the Assembly Pane can speed

up your work significantly.

First read about the different modes of operation for the Assembly Pane in the
Assembly Window section of the Maxsurf manual.

Again, as you get more experienced using Maxsurf you will develop your own

personal preference with regards to using the Assembly Pane. The experience is

that having the assembly tree docked on either the right or left side of your

screen provides quick access to right click commands and speeds up your work.

Assembly Window - Video

#= View a video that will show you the different window options for the
Assembly Pane. [Web | Disk]

Continue with the section on the Properties Pane.

Properties Pane

The properties pane is very similar to the Assembly Pane in the way that it can

be floating, docked or auto hide. The Assembly Pane and the Properties pane can

also be docked together into one pane or as tabbed panes.
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C:\Program FilesiMasesurf 1 3015:

Regular docking and floating options for properties pane same as for the Assembly Pane.

When you drag the Properties Pane on top of the docked Assembly Pane, you
will see the following:

EH|Maxsurf, Professional - [Body Plan]

Properties pane docking position:

" File Edit Wew Markers Contrals  Curve 1: Above Assembly pane
D) 9 2: To the right of Assembly pane
? : o 3: Below Assembly pane
: i =
assembly m s s 4: To the left of Assembly pane
£3 Desian 5: To the left of Assembly pane as a

separate pane
6: Underneath the Assembly pane into
a tabbed pane.

Assembly o ox
=3 Design
+-£3 TransverseCylinder
4@ Hull
% Tranzom
i Deck

Properties

Ready THS Assembly({ Proptuas

Properties

Properties pane docking in the same area as the Assembly pane has different options.

Continue with the section on Working in the Perspective Window.

Working in the Perspective Window

Working in the Perspective Window — Concepts

We will now explore two viewing options unique to the Perspective window —
rendering and rotation.
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Working in the Perspective Window — Video

& View a video that will show you how to rotate the model in the Perspective
view window using the slider bars and free rotate. The video also shows how to
render the model and toggle different light sources. [Web | Disk]

Working in the Perspective Window — Procedures

Render

» Click within the Perspective window to make it active or use the
Windows menu or toolbar.

To get a realistic 3-D representation of the model as a solid body, you can render
the surface.

> Go to Display | Render and ensure that the dialog box appears as
below before clicking OK:

Rendering Selection E|

v Hidden Surface Elimination
" Simple shading
* Smocth shading

[ Show suface contours
[ Highlight surface edges

" Gaussian Curvature I

" Longitudingl Cureature B

" Trangverse Curvature
" Caonvesity —

v OpenGL Hardware Acceleration

To maximise the light incident on the surface,

» Activate the four light sources in the Render toolbar:

£ Perspective

VU U NI Y T

The model rendered in Perspective window with all four light sources switched on.

Rendering only works in the Perspective window. The Display |
Render as well as the Render toolbar are disabled when the

Perspective window is not active.

Rotate

The Rotate function lets you freely rotate a design in the perspective window.
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TrainingVideos/WorkingInThePerspectiveWindowP.avi

. & .
> Select View | Rotate or use the ™~ toolbar button from the View
toolbar

» Move the cursor to a location in the Perspective window and press
the left mouse button

» Keeping the left button depressed, rotate the image by moving the
mouse around

The rotation is performed by projecting the cursor movements onto a virtual
sphere in the perspective window centred on the centre of the surface —
essentially the rotate function performs like a virtual trackball. Generally
speaking, moving the mouse left and right rotates the model about a vertical axis
while moving the mouse up and down rotates it about a horizontal axis.

> Release the left mouse button to exit the Rotate mode.

To rotate the model with greater accuracy and control, you can use the pitch, roll
and yaw slider bars on the sides of the perspective window.

> “Grab” the yaw control block within the yaw scale by clicking it,
and while still holding the left mouse button, drag it over the 0
(degrees) marker.

> In the same way, set the pitch and roll to 0
You should end up with something like this:

£ Perspective

&
&

1 1
i
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w
\y
8 =T

2

180 \ 120

T [ r r 1Tt t [ r t 1T 1 [ " ,r T T T [ T T T
-0 0°vaw |9:I 1

1 = Pitch, 2 =Yaw, 3 = Roll

Continue with the section on Displaying Contours.

Displaying Contours

Displaying Contours — Concepts

An alternative to using rendering to visualise the shape of a surface is to make
surface contours visible.

Displaying Contours — Video

& Watch a video that will show you how to toggle the display of different
contour lines in different windows using toolbar buttons and the Contours dialog.
[Web | Disk]
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TrainingVideos/DisplayingContoursP.avi

Displaying Contours — Procedures

> In Perspective window, switch rendering off by clicking on the

|g| toolbar button

» Change the pitch to 15° and the yaw to 45° to better visualise the

contours
» Go to Display | Contours and tick the sections box:

Contours ]

Select contours to be displayved

v Sections

[ Buttocks

[ Datum Waterline
[ Waterlines

[ Diagonals

[+ Edges

v Bonded Edges
[~ Feature Lines
[ Parametrics
[ Intersections

[ Trimming Curves

[~ Surface Curves

[ Inclined Sections

[ Deducted Sections Cancel

The sections define the intersections between the surface and numerous
transverse planes through the model.

» Switch to Body Plan window

£ Body Plan

> Now switch to Profile window

EH Profile

L J

- t Ty P

Sections are not displayed in the Profile or Plan window
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Though the sections would appear as vertical lines on the screen in both the
profile and plan windows, since these lines would bear no information about the
shape of the sections, they are not displayed.

» In the Contours dialog box, uncheck sections but tick the buttocks
box

EH Profile

- &

++ -21.818 53 10,145 ¥y 35.4° 502

> Switch to the Plan window

The buttocks define the intersections between the surface and numerous vertical
longitudinal planes through the model. For the same reasons as above, they do
not appear in the Plan or Body Plan windows.

» In the Contours dialog box, uncheck buttocks but tick the
waterlines box.

++ -6.918 $ 70 Wy 23557 W 9878

The waterlines define the intersections between the surface and numerous
horizontal longitudinal planes through the model. For the same reasons as above,
they do not appear in the Profile or Body Plan windows.

> In the Contours dialog box, check Sections, Buttocks and
Waterlines

» Switch to Perspective view

[ Perspective

In the Perspective window, all contours are displayed

Continue with the section on Working in the Body Plan window.
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Working in the Body Plan window

Working in the Body Plan Window — Concepts

The body plan window displays the transverse sections as seen from aft of the
model. Starboard is on the right of the centreline. Working in the Body Plan
view window is different to working in Plan or Profile because in Body Plan you
are looking down the length of the vessel which can appear quite messy. In Plan
or Profile you are looking from the bottom or starboard respectively and this
usually does not look quite as confusing:

£+ Body Plan EEE EE=®

« 10438 % 7466
Body plan

Yy 3567 ++ 37143 3 13122

Plan

Y 3405

In the image below, 22 sections are displayed in one 2D window. Even though
the eye of the naval architect is trained in interpreting images like this and
translate this into a 3D shape, it can sometimes be difficult to establish the
longitudinal position of a particular section along the length of the hull. This is
why the Body Plan window has an extra feature built in: the Control Box. This
powerful tool allows you to select the station you would like to display or the
column of control points you wish to modify. This enables you to do some useful
modelling in the Body Plan window and manipulate the shape by working one
section at a time. In the procedures below we’ll have a closer look at this control
box.

You can identify three regions in
Sy the Body Plan window:

1. Main view window area
2. Control box
R6O0G0000EAGE00 3. Coordinate display
3
[ 4+ 11245 $ 048 Y 25 " 11.256 I

Half hull display in Body Plan view

Tip: As with most Windows in Maxsurf, but especially in the Body Plan view, it
is important to make sure you display only the data that you need using the
Contour display dialog or toolbar buttons.
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Working in the Body Plan window — Video

# View a video that will show you the different view options in body plan such
as Show/Hide Net, Display/Hide Sections and how to use the control box to

switch between sections or switch your active column of control points.
[Web | Disk]

Working in the Body Plan window — Procedures - Introduction

Introduction to the Body Plan view window

» Open the Maxsurf Sample_Trawler.msd sample file from the
c:\program files\Maxsurf\Sample Designs directory

» Maximise the Body Plan view:

» Display only the Edges and the Sections

» Select Display | Half or use the |E| toolbar button

Working in the Body Plan window — Procedures — Control Box

Using the Control Box
»  Switch the sections off

You should now see just one section displayed on your screen:

51 Body Plan EE&®

[T

|
—

section|
+ 11.082 43745 ¥y 2333 N 6.558

The control box is a miniature view of the plan shape of all currently visible
surfaces — in this case just the one surface modelling the trawler’s hull.

srand -
section \ -
marker

a 0O 0 O o0 40 o0 4o 4 o0 o 4o o0 4 oo

At the top of the control box several short vertical lines are drawn. These are the
section or station indicators; there is one indicator for each of the sections
specified in the Grid Spacing dialog.

» Click in the control box near the stern of the ship:
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4 O O 0 0 O o0 0 0 o0 40 o0 O 4 o0 ‘ﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁaﬁﬁ
%B’/)
The current section marker line shows which section is currently displayed.

When a point in the control box is clicked, the nearest section will be selected.
Notice how in the Body Plan window the current section has changed:

-

After clicking in the control box, you can use the arrow keys on your keyboard
to scroll through the sections. The right arrow displays the next station forward
and the left arrow displays the next station aft.

» Use your keyboard keys to scroll through the sections of the
trawler model

Working in the Body Plan window — Procedures — Half Display

Half Display

When working in Body plan you will usually toggle the section display on/off to
visualise the effect of a change to one section on the 3D shape. When all sections
are displayed simultaneously, the display can be a bit messy. The Half display
can then help to clean the display up.

£
/; |
Y l'#ﬁéﬁﬁ

NS

> Switch Display of sections off
> Switch Display | Half off

Notice how the section is now mirrored to the other side of the centreline. Also
notice how the control box current section marker is now drawn across the
centreline.

» Switch display of section on

Notice how the control box now displays all sections with the current section
marker drawn with a thicker line:
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Control box with all sections displayed and half hull display off

» Switch Display | Half on

4 0O 0O 0 O 0 0 o0 o0 o0 o0 o0 o0 o0 o0

Control box with all sections displayed and half hull display on

When Half hull display is switched on, Maxsurf automatically determines which
sections will be displayed on the right and which on the left of the centreline.
There is a way for the user to overrule this default split location on a surface-by-
surface base. This is not covered in the LearningMaxsurf training manual.

Note:

When the cursor is within the control box the horizontal cursor
coordinate at the bottom of the Body Plan window refers to the
cursor’s longitudinal position within the control box.

For the control box to work correctly it is important that the Frame
of Reference is setup correctly. You will learn about this later; just
remember this at this stage.

Continue with the section on Zoom, Shrink and Pan.

Zoom, Shrink and Pan

Zoom, Shrink and Pan — Concepts

In all Maxsurf view windows you can zoom, shrink and pan to manipulate the
way that the model is displayed. Additionally Maxsurf lets you set a Home view
that remembers a particular zoom & position of the model on the screen.

Zoom, Shrink and Pan - Video

99 View a video that shows the use of zoom, shrink and pan commands. This
video also shows how to customise the home view to your own personal
preference and use the Home view command. [Web | Disk]

Zoom, Shrink and Pan — Procedures - Zooming

Zoom

The Zoom function allows you to work on any part of your design by enlarging a
particular area to fill the screen.
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The zoom function works in any of the Maxsurf drawing windows. To
demonstrate how it works,

> Click on or otherwise activate the Profile window

» Select Zoom from the View menu (or use the keyboard equivalent
Ctrl+E).

A cross hair will appear that follows the movement of the mouse. This is used to
set the starting position of the zoom rectangle. Supposing we wish to zoom in on
the bulbous part of the bow profile:

> Click and hold the mouse from approximately this position:

£ Profile BEE

++ -9.4493 A RAL ¥y 173.3° W 9.563

» Drag the mouse to form the following zoom rectangle:

£ Profile FEE

L.

e

+ 1644 3 -3674 ¥7y 336.6° W™ 12,081

The zoom rectangle will grow as the mouse moves.
» Release the mouse button.
The view contained in the zoom rectangle will be enlarged to fit the screen.
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£ Profile BEE
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There is a limit on how far you can zoom; you will find that after continual
zooming the image will not enlarge any further.

If, before releasing the mouse button, you decide that you do not
wish to use Zoom, or that you wish to change the starting position
of the zoom rectangle, simply return the cursor to within a few
pixels of the starting position, release the mouse button, and the
cross hairs will reappear.

Zoom, Shrink and Pan — Procedures - Shrinking

Shrinking

Choosing Shrink will reduce the size of the displayed image in an active drawing
window by a factor of two.

To shrink the displayed image:

> Select Shrink from the View menu.

Tip: You can also use the shortcut key Ctrl + R or the 2 toolbar button.

» Shrink the image until the entire profile is contained within the
Profile window

i1 Profile

++ .65 1+ -1.828 K™y 351.5° W 18648

Zoom, Shrink and Pan — Procedures - Panning

Panning
Choosing Pan allows you to move the image around within a drawing window.
To Pan an image:

> Select Pan from the View menu.
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» Click anywhere within the window and drag the drawing to a new
position,

F+ Profile

++ -16.961 % 0861 LARFrAN W 16.983

The image will move with the cursor until the mouse button is released.

Tip: you can also use the i toolbar button or hold down the scroll wheel of
your mouse to Pan.

Zoom, Shrink and Pan — Procedures — Home View

Home View

When you select Home View a zoomed or panned image is returned to a
particular state. This state may be set at any time for any combination of
zooming and panning by selecting Set Home View from the View menu.

» In Profile view, zoom in on the bulbous bow again
> Select View | Set Home View

» Now Zoom out a couple of times

> Select View | Home or use the fa! toolbar button

Notice how the display returns to the Home view as you specified it earlier.

Note:

Maxsurf starts up with default Home View settings, which are based
on the Home Views in use the last time the program was operated.

If a Home View is set within the Perspective window, the specific
rotational orientation of the model will not be restored if the model
is rotated and Home View is selected.

Continue with the section on Measuring Coordinates in Maxsurf.

Measuring Coordinates in Maxsurf

Measuring Coordinates in Maxsurf - Concepts

Maxsurf has defined its views to be consistent with Naval Architecture standards
throughout all view windows.
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+ve forward -ve aft

+ve starboard -ve port
+ve up -ve down
Window View direction
Body plan Looking forward from the stern
Profile view Looking from starboard, bow to the right
Plan view Looking from below, starboard above the centreline

In the case of the sample trawler, the origin of the coordinate system at the
forward-most point on the model’s waterplane, as illustrated by the = symbol in
the profile view of the trawler:

EH Profile

In the design view windows, other than the perspective view, Maxsurf displays a
number of co-ordinates and measurements in the bottom-left corner of the
windows.

Measuring Coordinates in Maxsurf — Video

#= View a video that will show you how to measure absolute and relative
coordinates and angles in Maxsurf. [Web | Disk]

Measuring Coordinates in Maxsurf — Procedures

To ensure that coordinates are interpreted correctly, the units must be set as
desired.

> Select Units from the Data menu and select Metres for Dimension
Units.

> In the Profile window, left-click the aft intersection of the datum
waterline and the surface’s edge. (Point A)

» Now move the cursor towards the bow and hover at point B. As
you do so, watch the coordinates change in the coordinate bar in the
bottom of the Profile window.
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TrainingVideos/MeasuringCoordinatesP.avi

EH Profile
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1. The horizontal coordinate in metres of the cursor’s tip (Point B relative to the
origin). The horizontal axis is relative to the screen, e.g. here the horizontal
axis runs longitudinally but in the body plan view the horizontal axis runs
transversely.

2. The vertical coordinate in metres of the cursor’s tip (Point B relative to the
origin).

3. The counter-clockwise angle in degrees between a line connecting the
cursor’s tip (B) and the clicked point (A) and a line running right from the
clicked point (in this case the waterline to the right of point A). If no point
has been clicked, the angle is relative to the origin.

4. The relative distance in metres between A and the cursor’s tip B. If no point
has been clicked, the distance is relative to the origin.

Continue with the section on Using the mouse in Maxsurf.

Using the mouse in Maxsurf

This section describes different mouse techniques that you can use throughout all
of the Maxsurf applications.

Right Mouse button

Maxsurf supports several right click mouse actions. Right clicking on selected
objects brings up a so called “right click menu” that lists the most commonly
used commands applicable to that object. For example after right clicking on a
surface in the Assembly Pane can give you quick access to the Surface
Properties:

[ assemdty 2 x B

=3 Design
Ja ™

add Assembly

Delete
Rename

Hide:
v Show

v Lock
Unilock,

Skart krimming

e I

Right click menu
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Using right clicking can greatly speed up your work.

Using the Mouse Wheel

You can use the mouse wheel to easily zoom into and out of a design. You can
use this feature if you have a mouse with a ‘wheel’ in the centre of the mouse,
i.e. Microsoft Intellimouse or Logitech Wheelmouse.

Rolling the wheel forward zooms in and rolling it backwards zooms out. When
zooming in with the mouse wheel, the zooming will be centred on the centre of
the drawing window. To zoom in on a particular area, View | Zoom or Ctrl + E
must be used.

Holding down the mouse wheel to pan is also supported.

Continue with the section on Undo / Redo.

Undo / Redo

Since a lot of work in Maxsurf is iterative and based on trial and error, it is
important to make note of the Undo and Redo capability in Maxsurf.

Changes can be Undone from the Edit menu. An action that has been Undone
can be redone from the Edit menu as well. In the image below you have the
option to redo the deletion of the surface, or undo the most recent control point
move.

£ Maxsurf, Professional - [Perspective]

. File | Edit | wiew Markers Controls  Sur
¥ :;l%gndo (idd Surface) Ctrl+2

(4 Redo(Delete Surface)  Chri+Y

@

Each time a change is made Maxsurf stores a copy of the file into the RAM
memory of your computer. The number of Undo levels that Maxsurf stores is set
in the Edit | Preferences.

The fastest way to Undo and Redo is by using the Ctrl + Z and Ctrl
+ Y shortcut keys respectively.

Save regularly. Additionally use different file names if radical
changes are made to the model.

Congratulations! You have now completed the Chapter 3 User Interface.

Continue with the Chapter 4 NURB Surfaces section on the next page.
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Chapter 4 NURB Surfaces

Before you can start to create your first model it is important to understand the
basic principles of surface modelling in Maxsurf. Understanding the basic
principles behind NURB surfaces will improve the quality of your Maxsurf
models and your ability to produce them significantly.

> % Read Chapter 2 of the Maxsurf manual on Basic Principles
(Ignore the link to “Working with Surfaces”).

From this you should at least remember:

1. That the net of control points is always topologically quadrilateral; there
are four corner control points and four edges. The control point net is
arranged in rows (which run longitudinally) and columns (which run
transversely). Each row has the same number of control points as every
other row and each column has the same number of control points as
every other column.

2. A surface always consists of 4 corner control points and may consist of
additional edge control points and internal control points.

Continue with the section on Surface Stiffness.

Surface Stiffness

Surface Stiffness — Concepts

% In Chapter 2 of the manual, the stiffness of a spline curve was compared to
the stiffness of springs altering the shape of a wooden spline/batten. This analogy
also holds when you think of the fact that if the wooden spline itself were stiffer,
its curvature when loaded transversely would be lesser. Similarly: when drawing
a smooth shallow curve you could select a stiff spline, and when drawing a curve
featuring a high rate of change of curvature you could select a flexible spline.

Py

A Perspe;( batten is used to draw a spline. Its stiffness determines how much curvature can be
drawn.

In Maxsurf there are a number of stiffness levels or “orders” for both the
longitudinal and transverse directions of the surface:

Linear Order 2
Flexible | Order 3

Stiff Order 10

The order reflects the number of coefficients used in the polynomial that
describes the spline’s shape. For example: the order 2 polynomial
“y=a-X+b” uses 2 coefficients ‘a’ and ‘b’ and describes a straight line (read:
linear curve).
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When using NURB surfaces, flexible surfaces are useful for modelling knuckles
(a region on a surface with sudden or very high change in curvature) and
discontinuities.

Surface Stiffness — Video

& Watch a video that shows you the effects that a change to the surface
stiffness has on the shape of a spline. [Web | Disk]

&% Watch a video that shows how a change in stiffness affects the shape of the
surface. [Web | Disk]

Surface Stiffness — Procedures — 2D Curve

2D Curve

In the section on Basic Fairing we will discuss stiffness further, but first let’s
have a look at the effects of stiffness on a curve:

> Maximise the Profile window

» Open SurfaceStiffness2D_start.msd

[ Maxsurf Professional - [Profile] (=)
© File Edit Yiew Markers Controls  Suwfaces  Display  Data  Window  Help -8 X

= | Gle. aaes @, o 2@pieris?
. EEEE e EmReE. Uze BF o

Assembly nox
=-£3 Design
% 2D Curve

w4005 $ 3634 w7y 323.1° 6134

Vitraininglic$\Docurments and Settingsiterence\De

The model consists of a single chain (or “row”) of control points that produces a
spline that lies in a single plane (you can see this in the Plan and Body Plan
windows). Thus the model is best viewed in the Profile window. The ‘curve’
produced is simply a jagged line connecting the control points.

> Inthe Assembly pane on the left, right click the surface 2D Curve
and open the Properties dialog. (If the assembly plane is not visible,
go to View | Assembly).
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http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/effects-of-surface-stiffness-on-a-2d-curve#4uU7jvW9i7JVhsF99qRWqQ
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Delete ransverse: ¥ Sol . .
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Appearance:

w Show 2 [linear] - " projects inside of suface
Lock " is centred around surface

W Unlock Surface Use: Tranzparency: * projects outside of surface

Cancel

E5]

Currently, the transverse surface stiffness is set to 2 (linear).
» Increase the longitudinal surface stiffness to 3 (flexible).

The curve now remains closer to the line between end control points. Note that
the curve runs at a tangent to the control point net (blue) at the end points. This is
true for splines of all stiffness orders. In the case of an order 3 spline, the curve is
also tangential to the control point net at the midpoint of the net lines between
successive intermediate control points (i.e. at points A and B below):

EH Profile

- 1 Yy e

» Undo (Ctrl + Z) and Redo (Ctrl + Y) the change in stiffness to best
study the effect of the change

» Increase the longitudinal surface stiffness to 4, then 5

Notice how the spline displaces less and less from the line between the end
control points.

> Try selecting a stiffness of order 6 from the longitudinal stiffness
drop-down menu. What happens?

A stiffness of 6 is not allowed because the order of the surface stiffness in a
given direction must be less than or equal to the number of control points in that
direction. Here there are 5 control points in a row so the maximum stiffness in
the longitudinal direction is 5.
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% The reason for this relates to the mathematical definition of a spline of
certain stiffness or order. If a polynomial has five constants, at least five points
on the curve (or influencing the curve, like the control points) are required to
solve the constants and define the curve.

Maxsurf will make sure the stiffness of the surface cannot be greater
then the number on control points in that direction; i.e. if you have
an order 6 surface and you reduce the number of columns from 6 to
5, Maxsurf automatically reduces the surface stiffness from 6 to 5.

Surface Stiffness — Procedures — 3D Surface

3D Surface
To extend the concept of surface stiffness from a curve to a surface,

» Open SurfaceStiffness3D.msd. If prompted to locate the materials
and shapes library, click Cancel.

To best view the effect of changing the stiffness of the surface,
» Maximise the perspective window.
» Set pitch to 0, yaw to 60 and roll to —60.

> Go to Display | Net and select Show Net to view all control points
and the net.

> Go to Display | Contours and turn on sections and buttocks.

The surface stiffness is initially set to 2 (linear) in both directions. Notice that the
sections and buttocks follow the shape of the control point net perfectly.

=)

o

> Change the stiffness is both directions to 3.

Notice how the longitudinal surface edges and the buttocks, as well as the
transverse surface edges and the sections have smoothed away from the control
point net.
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» Change the stiffness in the transverse direction to 4 and in the
longitudinal direction to 5 (the limits).

Observe how the edges, sections and buttocks are even smoother and that the
entire surface is more planar.

Continue with the section on Surface Precision.

Surface Precision

Surface precision - Concepts

In the previous sections you have learnt that NURB surfaces consist of control
points and certain stiffness properties. In this section you will learn about what
Maxsurf does with this surface information in order to display the shape of the
surface.

@ The NURB surface shape is defined solely by:
e The surface stiffness
e The position of the control points

e The weight of the control points (recommended to leave at weight = 1)

Based on these three ingredients, Maxsurf can calculate the shape of the surface
at any given point on the surface. For example, Maxsurf can calculate the
position halfway along one of the edges, or at any random location inside the
surface. This way Maxsurf can theoretically turn a NURB surface into a point-
mesh with infinite density. However, this calculation would take an infinite
amount of time and saving this mesh to a file would result in a file of infinite
size. Alternatively, Maxsurf can divide the surface up into a mesh with a specific
number of segments along each edge (for example 16 segments). This would
result in 16 x 16 = 256 mesh points which can be used to display the shape of the
surface or exported into a data file. This mesh is called the “Parametric Mesh”.
The number of segments in this Parametric Mesh is determined by the Surface
Precision.

The number of segments used to display the shape of the
surface is set by the Surface Precision.
Below you will look at the shape of the trawler sample design at different
precisions:
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Surface mesh with 8 segments Surface mesh with 32 segments

Surface precision - Procedures

> Open the Maxsurf Sample_Trawler.msd file from c:\Program
Files\Maxsurf\Sample Designs

> Go to Windows | Plan
> Display | Precision | Medium

> Display | Contours | Parametrics or use the  toolbar button.

Contours X

Select contours to be displayed

[ Sections

[~ Buttacks

[~ Datum Waterline
[~ waterlines

[ Diagonals

v Edges

[v Bonded Edges
[ Feature Lines
v Parametrics

[ Intersections

[ Trimming Curves

[ Surface Curves

[~ Inclined Sections

I” Deducted Sections Cancel

You should see something like this:

ALl

i

At Medium precision there are 32 line segments along each edge.

» Now switch Data | Precision to Lowest:

At lowest precision there are 8 line segments along each edge
Notice that each line segment is drawn by a straight line.

» Now switch to Data | Precision | Highest
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Highest precision starts with 64 segments and inserts more where it needs to for greatest accuracy.

It is beyond the scope of the LearningMaxsurf training to go into details any
further. All you need to remember is that the Precision setting does not change
the shape of the surface (shape is determined only by stiffness and control
points), but determines how many line segments are used to display the shape.

In the rest of the LearningMaxsurf training you will only work at the default
precision (medium).

Continue with Chapter 5 Designing in Maxsurf.
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Chapter 5 Designing in Maxsurf

% When designing in Maxsurf, a naval architect has several options to choose
from:

e Use a similar existing design and modify it to design requirements

e Start from a new design scratch

Which of these options is most cost efficient is difficult to predict and dependent
on:

The required hull shape

The Maxsurf Sample Designs directory contains a wide range of hull forms that
can be used as a starting point. If the shape of the intended design is close that of
one the sample designs, it will save you a lot of time if you use the sample
design as a starting point. It is definitely worth while familiarising yourself with
the sample designs in: c:\program files\Maxsurf\Sample Designs.

The purpose of the surface model and surface type

If your model is used for production purposes then it will need to be created from
a faired NURB surface, the user will have to think carefully about the surface
topology of the intended design before starting. The reasons for this are
explained further in the intermediate section of this training manual.

If the model is intended only for analysis purposes, then hull shape can be
created as a TriMesh Surface. A TriMesh surface is a linear surface made up of
triangular facets. It is not a NURB surface, it does not have control points, and it
cannot be trimmed with NURB surfaces.

The TriMesh surface is not designed to be smooth — it follows the input data
points exactly and is linear between the data points. The Markers should provide
sufficient detail for the purpose to which the model is going to be put such as, for
example, hydrostatic and/or seakeeping analysis in Hydromax, Seakeeper and
Hullspeed.

For more information see the section on Generating a TriMesh surface in the
Maxsurf User manual and_Importing dxf Marker Data & Generating a TriMesh
model Tutorial.

The user’s experience in Maxsurf

An experienced user may get to a good starting point for a hullshape much faster
than a new user. A new user to Maxsurf may feel more comfortable starting with
a similar existing design, while a more experienced user can make a design
completely to his own liking by starting from scratch.

Note that the dimensions and the design category (eg leisure vs. commercial etc)
are not in the above list. A sailing boat hull shape may offer a good starting point
for a frigate for example. Maxsurf offers a range of tools to quickly resize
surfaces. In Maxsurf Pro there are even tools to change design coefficients such
as LCB, Cb and Cm etc. Let’s first get an idea of what is involved in starting a
Maxsurf design from scratch.
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Let’s get started! Go to the Starting a Design from Scratch section.

Starting a Design from Scratch

% When you start a design from scratch, you literally start with a blank piece
of paper. Earlier in this training manual the use of Maxsurf was compared with a
creative process like painting. Imagine that a painter wants to paint a portrait of a
person in front of a backdrop of trees and mountains. How and where should the
painter start painting? He can choose many different ways and each painter will
chose differently. This is very similar in Maxsurf: the designer has a vision of a
design and a blank piece of paper (or 3D space). His creativity as well as a good
knowledge of the tools available to him will enable him to achieve his vision
step-by-step. The order in which he does things and the tools he uses along the
way are not pre-defined and can not be learnt from a book. This section of the
training manual teaches you one particular way of starting a design from scratch
and teaches you the use of several design tools along the way. This will help you
achieve your vision of a design in your own creative way.

Start with the Starting a Design section.

Starting a Design

Starting a Design — Concepts

Before you can start modelling it is a good idea to create the environment in
which the design will be created. Compare this to choosing the size and materials
of a canvass in the case of the painter if you like.

Starting a Design — Video

# Watch a short video that shows you the first steps of starting a design from
scratch: Starting a New Design, Inserting a Default surface, techniques to add
rows and columns of control points in different windows, saving your design.
[Web | Disk]

Starting a Design — Procedures — New Design

New design
If you have an existing design open, first close it:

» From the File menu select File | Close Design
Now start a new design:
> Select File | New Design from the File menu

This will give you a blank workspace without any surfaces. In the following
series of tutorials you will model a single surface monohull with a round-bilge
hull form:
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Starting a Design — Procedures — Adding a Surface

Adding a Surface

The first thing to do is add a surface, so that you can then manipulate this into
the required shape.

> From the Surfaces menu select Surfaces | Add Surface | Default

The “default” surface is a good starting point for most designs.

The diagram below is similar to what should be shown on your screen (Note that
the display may vary due to the display settings you are using):
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Before you start modelling, you should set up the units and overall dimensions
for your design.

Starting a Design — Procedures - Units

Units
Select the units you would like to use

> From the Data Menu select Units
> Complete the dialog box as follows:
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Dimension Units?

* Metres " Feet & Inches
" Centimetres " Decimal Feet
 Milimetres " Inches
‘Weight Units?
& Tonnes " Long Tons

" Kilograms " Pounds Cancel

Note that the units you have selected are saved as Maxsurf preferences and are
not stored with the design.

Starting a Design — Procedures — Sizing Surfaces

Sizing Surfaces
Now we can make the surface approximately the correct size for the design.

> Select Surface | Size Surfaces

Size Surfaces 3]

Select Surfaces to resize:

Select 4l | DeseleclAII|

J Default Propartional
Scaling

r il Length
r Mm il Beam
I lem il Depth

[ rezcale markers

Cancel

This dialog may be used to resize one or a selection of surfaces in the design.

» Place a tick next to the surfaces you wish to resize
» Enter the values as in the dialog image above.

Starting a Design — Procedures — Saving

Saving Your Design

You now have a single surface that can be manipulated into the required design.
At this stage it is a good idea to save your design. To do this, make sure that you
have activated one of the View Windows and choose:

»  File| Save Design As, specify where you wish it to be saved and
name the file MyFirstDesign_start.msd

You should get into the habit of regularly saving the design before and after
major design changes. This is easily done by clicking on the save icon = or by
using the shortcut Ctrl+S.

Maxsurf only allows you to save your surface model when you have one of the
View Windows (i.e. Body plan, Profile, Plan or Perspective) frontmost or
“active”. All Maxsurf applications work this way. You can see how this works

by:
» Switching to the Control Points window
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» Going to the File menu
Notice how the “Save Design” has changed into “Save Control Points”
» Switch back the Body Plan window

Starting a Design — Procedures — Adding Control Point Rows

Adding Control Point Rows

The default surface contains 3 rows and 3 columns of control points. To get the
shape you desire, it may be necessary to increase the number of rows and
columns in the surface. In this section we will take a closer look at how to add
and remove control points in the net.

Always try and use the minimum number of control points to
achieve the desired surface shape. You will learn why this is in the
section on Basic Fairing.

The number and position of the control point rows affects the surface’s shape in
Body Plan view. Adding control point rows will give you more control over the
section shape.

You can add and delete control point rows only in the Body Plan
window.

> Switch to Body Plan view

To add a control point row, it is best to turn off the net so that you can only see
one control point column.

» Make sure the net is turned off, you can do this from the menu
(Display | Net) or =
To add a row, go to the body plan view, select Controls | Add Row or click the
# toolbar button. You will see a crosshair appear.

> Insert a control point row as in the figures below
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» Switch to Perspective view

» Switch the Net on, Half on, and Hide the Grid from the Display
menu:

Default surface with the extra rows.

Notice that the row is inserted into all the columns. Maxsurf will interpolate the
insertion point in the other columns based on the position where you inserted the
row into the current column.

> Remember to save your design regularly

Starting a Design — Procedures — Adding Control Point Columns

Adding Control Point Columns

After adding the rows, you can now proceed to add some columns. Adding rows
or columns does not have to be done in any particular order. The number of
columns affects the shape of the surface in Profile and Plan view. Adding control
point columns gives you more control over the waterlines and buttocks. Adding
control point columns work exactly the same as adding rows, except it can only
be done in Plan and Profile view.

You can add and delete control point columns in Plan and Profile
window.

> Switch to Profile view = and turn on the Net 2 .

Control point columns are added by clicking at a position on a row of control
points. For example:

Clicking here: Will insert a column here:
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Clicking here: Will insert a column like so:
-__—""é#:-\\—m_

===

» Insert two columns of control points so that your design looks
something like this in Profile view:
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Starting a Design — Procedures — Deleting Control Points

Deleting Control Points

Deleting a control points row or column is easy. In this section we will delete a
control point row from the body plan view.

> Switch to the Body Plan window and hide the net

> Select Controls | Delete Row or click the Pac-Man % toolbar
button

» Place the jaws of the Pac-Man over the control point row you wish
to delete and click the left mouse button

—

> Switch to Perspective view

> Render the Surface in Smooth Shading:

» Save your design as MyFirstDesign_Start.msd

r‘-?Feel free to practise adding and deleting rows and columns. It may be a good
idea to save your design first.

Continue Design Preparation.
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Design Preparation

Design Preparation — Concepts

After you have setup your surface to be roughly the right size and inserted the
number of rows and columns that you expect you will need to achieve the
required shape, there are a few things you have to do before you can start
manipulating the shape of the surface.

Note that the order in which things are done in this tutorial is not a set sequence
of steps and you are free to do whatever you like at any point during the design
process. The sequence in this tutorial ensures that you have for example your
surfaces roughly the right size before you setup your grid so that you only have
to do that once.

Design Preparation — Video

&= Watch a short video that shows you how to setup the Frame of Reference
and the Zero Point and define the Grid. [Web | Disk]

Design Preparation — Procedures — Surface Properties

Set Surface Properties

Before moving the control points in your design, you should review the surface
properties. In general, you should select a B-Spline surface with the maximum
stiffness that will give you the surface you require. This will be an iterative
process, since the number of control points defining the surface limits the
maximum stiffness.

> Rename the surface and set the surface stiffness to the values in
the dialog below

Surface Properties L3
Geometry:
Surface Type: Surface Mame: |Hu||
* B-zpline
 MURE Viewing and Appearance: Phuyzical Properties:
" Conic Surtace Flags: Material
" Developable v Wisible | ﬂ
- [~ Locked
?urface shiffness: ¥ Symmetical Thickness:
rangverse: : - .
[v Split Section Dizplay
0 rm
-
Appearance: L
Longitudinal Direction:
5 - " projects inside of suface
" is centred around surface
Surface Use: Tranzparencsy: (% projects outside of surface
* Hull Shel
0 %
" Intemnal Structure
Ok | Cancel

» Make sure that the surface is symmetrical.
> Save your design as MyFirstDesign_Preparation.msd

We will look at the other surface properties later, for the moment this is all you
need.

Design Preparation — Procedures — Frame of Reference

Set Frame of Reference and Zero Point

Before proceeding to far into the design, you will want to set up a Frame of
Reference and Zero Point from which measurements are taken.
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» First, select Data | Frame of Reference
This will bring up the Frame of Reference dialog which allows you to position
the zero point, datum waterline, baseline and fore and aft perpendiculars:

The dialog shows a profile view of the vessel with the zero point ‘“+’ and the
Frame of Reference (forward and after perpendiculars, midships, baseline and
design waterline). The dialog radio buttons, edit boxes and buttons are arranged
in two groups: The first defines the longitudinal data for the frame of reference
and the zero point and the second group defines the vertical. It must be
remembered that all measurements shown are with respect to the “current” zero
point: that is the zero point that was in effect when the dialog was opened.

First set the longitudinal position of the new proposed zero point, under the
longitudinal datum:

» Tick the <Other> radio button

> Press the <Aft extent> button
This moves the longitudinal position of the new proposed zero point to the aft
extent of the hull.
Now set the vertical position of the zero point, under the vertical datum:

» Tick the <Baseline> radio button

» Press the <Find base> button
This moves the vertical position of the zero point to the base line and then finds
the baseline for the hull.

You will notice that in the Frame of Reference dialogue box the current zero
point is drawn as well as the new proposed zero point. The new proposed zero
point is drawn in a pastel shade of the current zero point.

Frame of Reference and Zero point @

Current zero point

New proposed

zero point
1/ Al

Longitudinal Datum - Vertical Datum
O atPep [om  SettoDwi | cowl om0
© Midships [om % Baseline [8.002m Find Base |
" Fud Pelp.rlllm— Setto DWLI " Other |-1_3m——
& Other Pl Aft extent
Fwd extent

oK Cancel
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Now set the location of the datum waterline. Note that this is relative to the
current zero point. In the datum waterline box

> Typein<-5m >

This sets the datum waterline to a vertical distance of -5meters from the current

zero point (+3m from the new proposed zero point)

Frame of Reference and Zero point @

- Longitudinal Datum - 1 i~ Vertical D atum -
C atPep. [om  SettoDwi| Cowl  [Em
C Midships [0m  Basene [6002m  FindBase
C FwdPep [0m  SettoDwi| C Other  [13m
® Other  |21m (lteasd]
Fwd extent

Now to set the longitudinal locations of the forward and aft perpendiculars:

Under longitudinal Datum, next to the Aft Perp:
> Press the <Set to DWL> button

Under longitudinal Datum, next to the Fwd Perp:
> Press the <Set to DWL> button

This sets the forward and aft perpendicular to the current location of the datum
water line.
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Frame of Reference and Zero point @

Aft Perpendicular - Fwd Perpendicular

Set to datum waterline
- Longitudinal D atum -

C AftPep. [21m Setto DWL | | DWL | 5m

" Midships |Om @+ Baseline |-8.002m Find Base
" FwdPerp. [21 m Set to DWLi ' C Other  [13m
Aft extent
@ Other 21 m ==
Rk etet |

oK Cancel

Design Preparation — Procedures - Grid

Insert a Grid

Before you can start modelling, you need some way to visualise the surface
shape while you are modelling. At this stage of design it is therefore necessary to
create a grid of sections, waterlines, buttocks and maybe also diagonals. These
contours may then be displayed on the design while modelling.

> Go to Data | Grid Spacing
You’ll see the following dialog appear:

Grid Space 3

g |Label| Station | Spiit 1 ™ Sections
m ™ Buttocks
™ waterlines
" Diagonalz

2 add
__cot | _Space |

4 DKl

Cancel
=4 |

The dialog can be divided up into the following regions:

1. Select the type of grid you want to work on, i.e. Sections, Buttocks,
Waterlines or Diagonals

Commands to Add, Delete, Sort or Space the grid type selected in 1.
Displays the current grid locations for the grid type selected in 1.

4. OK and Cancel to confirm or undo all changes made in the dialog.

w

> Select Sections
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> Click on the Add button to add Sections:

(% Sections
™ Buttocks
™ waterlines
" Diagonalz

Add Sections %]

Add how many Sections? Eﬂ
Cancel

Ok
Cancel

> Add 20 Sections and click OK

This will return you to the Grid Space dialog, which now shows the Grid on the
left (region 3 in the image of the Grid Space above). Next step is to specify the
location of the Section lines. You can do that for each section individually by
typing in region 3 directly, or — much faster:

» Click the Space button:

Label | Station | Split | A (& Sections
m ¥y " Buttocks

1 | st1 | 0000 I " wiaterines
2 | st2 0.000 r " Diagonals
3 | st3 0.000 r
4 | a4 0.000 r
5 | st5  ooo0 [ #dd Delete
E | =tg 0.000 r
7| 7 oo _ Sot | _Space |
Y oo
9 | sta 0.000

(2]

-

8 m
-]

]

Space Stations
7 Ewvenly along D aturn W aterling

{* Evenly along the length of the model

" Fram  Station thraugh

Feo
starting from Cancel

The Space dialog allows you to Space any number of selected sections over any
distance you specify. In the Maxsurf Intermediate training we will look at some
more advanced use of this dialog, but for now:

» Space the Sections Evenly along the Length of the model and click
OK

Notice how all Sections are evenly spaced from 0 to 40 m:
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Grid Space ®

Label | station | Split ‘ -~ (v Sections
m " Buttocks

1| st 40.000 r " i aterines
2 | =2 8.000 r (™ Diagonals
3 | st3 | 3sooo0 [
4 | st4 340 [
& | sts | moo0 Add Delete
§ | st6 30000 [
E A = i T _ sat | Space |
& | sta 26000 [
9 | sts 24000 [
10| st10 . 22000 [
M| st 200000
Mz] st12 18000 [
13| st13 16000 [
4| st14 14000 ¥ Cancel

Do NOT click OK in this dialog yet. You will first:
» Insert 4 Buttocks spaced evenly along the width
> Insert 5 Waterlines spaced evenly along the depth
> Click OK now

> Go to Perspective window, switch the Net off, Half on, and display
Sections, Buttocks and Waterlines:

You can now also Toggle the Grid display on/off from the Display | Grid menu

or using the % toolbar button. Note that this adds a lot of additional lines to the
display, especially in Perspective view, and may confuse you. Remember that
efficient modelling is all about displaying the least amount of information
necessary.

» Remember to save your model

» Save your design as MyFirstDesign_Preparation.msd

You now have a basic surface with a Zero Point, Frame of Reference and a grid.
The surface is approximately the correct length.

Continue with the section on Modelling .
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Modelling Corners and Edges

Modelling Corners and Edges— Concepts

%After you have set up a surface with approximately the right size, stiffness
and number of control points and have also defined a grid, zero point and Frame
of Reference, you can start shaping the design. Again you can do this in any
random order you like, but from the author’s experience there is a particular
sequence that works very well and it is recommended to follow this for now. The
most efficient way to manipulate the shape of this surface is by working your
way through the three types of control points from top to bottom:

e Corner control points
e Edge control points

e Internal control points*
* |If the difference between corner, edge and internal control points is not clear, read Chapter 2 of
the Maxsurf manual.

Following this order will prevent you from making unnecessary adjustments to
internal control points and reduce the number of iterations you will have to do to
achieve the desired hullshape.

Just to recap on the previous section in this training where we explored the User
Interface, here are some tips and tricks that are worthwhile remembering when
manipulating the shape of a design:

1. An adjustment to the shape in a 2D window influences the 3D shape and
thus in the other 2D windows and Perspective window.

2. Alternate between different view windows regularly when modelling

3. When starting a new model, make big changes first whilst alternating
between view windows and then slowly refine towards to required
shape. Don’t try to do it all at once in just one view window.

4. Arranging your view windows can improve your productivity. For
example: you can show all four view windows at the same time and see
how a change made in one window effect the hullshape in the other
windows.

Modelling Corners and Edges - Video

#% Watch a short video that shows you how to set the 4 corner control points
positions numerically, and then manipulate the edges in the different view
windows. This video also shows how to use the Control Box in Body Plan view
is used to activate different columns of control points. [Web | Disk]

Modelling Corners and Edges — Procedures — Corner Control Points

Positioning the Corner Control Points

Each surface consists of four corner control points. The corner control points can
be recognised by their colour or by following the edges to the surface:

4——— Corner Control point
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The location of the corner control point is the exact location of the
surface.

For a design that consists of only one surface, the location of the four corner
control points are more or less determined by the design’s Length, Beam and

Depth parameters as in the following table.

Corner | Position

cor_ltrol Height Offset Longitudinal position

point

1 Top of bow Centreline Fwd extremity

2 Top of Beam at Transom aft position
transom transom

3 Lower Centreline Transom aft position
transom

4* ? Centreline ?

* Corner control point number 4 is always very difficult to position.

>

Perspective is probably the best window to select the corner control points.

Corner | Position from zero point

control | Height | Offset | Longitudinal
point position

1 9 0 42

2 7.5 4 0

3 0.5 0 0

4 0.5 0 39

Enter the following coordinates for the four corner control points
by double clicking on each of them.
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When you look at your surface now in the different view windows, it looks
pretty messy. Don’t worry about this at the moment and more importantly: don’t
try to fix it by starting to randomly drag control points around. Trust on the fact
that the order of modelling: Corner control points =» Edge control points =»
Internal control points will sort it all out for you. Let’s continue modelling by
manipulating the edge shapes.

» Save your design MyFirstDesign_CornersEdges.msd

Modelling Corners and Edges — Procedures — Edge Shape

Manipulate the Edge Shape

» First read Chapter 3, section Moving Control Points of the
Maxsurf manual

To make sure you do not get confused by the large number of control points,

= =
> Hide the Net ™=, switch buttocks off

This hides the internal control points, so that you can concentrate on the shape of
the edges. You can now begin to manipulate the default surface into the required
design shape. This is simply a case of dragging the control points to their
required positions. In general, it is best to define the edges in the following
order:

> Switch to Profile View

When manipulating the edge shape in Profile view, move the control
points primarily up and down. Out of edge 1, 2 and 3 in the image below
you can start with any edge you like. Edge 4 (transom) will be adjusted in
Body Plan view.

» Drag the control points so that it looks something like this:

o 3 _FF——-—-_'_'_'n

O

[m]

4

|
| RE——

=

Tip:
Try not spending too much time on achieving the exact control
point positions at this stage. Modelling is an iterative process where

you increase the accuracy of the control points’ positions as the
design progresses.

You can see that the surface edge contour does not go through the
position of the edge control point. This means that typing in the
numerical values of the edges is not very useful. Remember to
imagine the surface being connected to the control points via little
springs or rubber bands.

> Switch to Plan View, switch waterlines off E , Half off, Hide Net.

In Plan view you shape the deck edge. You will see that your design
currently looks something like this:
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m]

[m]

u]

First thing we need to do now is use a multiple selection on edge # 2 (the
bow) like this:

--------

[m]

[m]

fa
L

With these edge control points selected,
» Controls | Control Properties

» Specify Offset = 0 and OK to move all control points to the
centreline and close the bow

Control Point Properties

Hull
Riow Colurnn 4

Long. Pos.

Offset

Height
ok I
Weight [ 1.0000
Cancel

[m]

'm] i n
Ll 1k Ll

% In the control properties dialog all properties that the selected control
points have in common are displayed. In this case the selected control
points do not share the same row number, longitudinal position, offset or
height, but do all have a weight factor of 1.000 and are all in column 4 on
the Hull surface.

» Switch to Perspective view to check your work so far:

Perspective view with sections displayed
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Smooth Shading rendering in Perspective view

When you are shaping your edges, do not:
- touch your corner control points anymore
- display your internal control points by showing the Net.

» Switch to Body Plan View, Hide Net, Sections off, Half on.

What you are looking at now is called the active column. When the Net is
hidden in Body Plan view, the only control points you’ll see in Body Plan
view are the “active column” control points. Active column control points
are the control points on the column that is associated with the control
point that you selected last.

Active row

Let’s have a look how this works:

> In Perspective view Select the following control point in the bow
column:

> Switch back to Body Plan:

1 = Section, 2 = Transom edge, 3 = Bow column of control points, 4 = Deck edge.
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> In Perspective window, select this control point:

In Body Plan you’ll see this column is now the active column and the deck edge
control point is selected:

The column that is displayed in Body Plan view when the
Net is Hidden is called the “active column”. This is the
column with the last selected control point in it.

The active column is indicated in the Body Plan window control box:

1 2 3 4 5
[5

. [+
X, Active column
of control points

=4
G|

The control box shows that there are 5 columns on this surface
of which the 3“ is the active column.
You can also switch active columns by clicking on the column indicators. When
you do that, Maxsurf also displays the Section that is closest to the active
column. This enables you to model on one column and its nearest section at a
time.

» Click on Column indicator #1 in the Control box in body plan
view.
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What you are looking at now is the Transom edge on the left and the transom

edge control points on the right.

\
=

The Transom edge Control points

> Drag the control points on the aft most edge so that it looks like
this (do not move the corner control points):

T

S

Let’s take a moment to have a closer look at the transom shape:

> Switch Half Off and zoom in on the centreline-transom point:

Notice how the transom edge is tangential to the control
point net from the corner control point to the next
adjacent edge control point. This is always the case for
all edges and is very important to remember!

This means that the following three scenarios are possible for the transom edge:
90

L]

“V-shaped” ““Smooth” “Tunnel bottom”

Let’s shape the transom so that it is smooth:

» Double click on the corner control point:
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Control Point Properties

Default
Row 0O Calumn 0
Long. Pos. 0 m
Offset Om
o
weight | 1.0000
Cancel

The height of the corner control point = 0.5 m

» Now double click on the adjacent edge control point of the
transom and set the height to 0.5 m as well:

Control Point Properties

Drefault
Row 1 Colurn 0

Long. Pos. |0

Offset 2305m
Height 05 m
ok |
— ‘Weight | 1.0000

You have now completed positioning the corner control points and modelling the
edge shapes.

» Save your design as MyFirstDesign_CornersEdges.msd

Modelling Internal Control Points

Modelling Internal Control Points — Concepts

After having positioned your corner control points and shaped your edges, it is
now time to shape the internal surface. It is at this stage important to force
yourself not to make any more changes to any control point that is either a corner
control point or located on an edge. If you think back about the analogy with the
painter painting the portrait, you are now probably at the stage where you have
positioned the object (the person) on the canvas with the right size and
proportions and sketched the outlines or contours. From here the painter can fill
in the rest of the portrait in any order and again each painter will have his
personal preferences.

You can chose to change the position of the internal control points using any
random window in any random order, but from the author’s experience a good
efficiency can be achieved using the Windows in this order:

1. Body Plan

2. Plan or Profile

3. Perspective

Also don’t forget that modelling in 3D is an iterative cycle and you will cycle

through steps 1 > 2 > 3 - 1... several times before achieving a reasonable
result.
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Modelling Internal Control Points — Video

& Watch a short video that shows you how the internal control points are
positioned in Body Plan view while using the control box to switch columns.
This video also shows how to use different view windows to track down any
irregularities in the control point net. [Web | Disk]

Modelling Internal Control Points — Procedures - Smoothing

Smooth Internal Control Points

After fixing the corner control points and shaping the edges, it is now time to
look at the internal control points.

»  Show the control point net

Usually after you have not shown the internal control points for a while and
made all sorts of changes to the edges and corner control points, the internal
control point net can be quite messy. In this case it is actually not too bad as can
be seen in the image above. There is a command available in Maxsurf that cleans
up messy internal control point net by distributing the internal rows and columns
evenly between the edge rows and columns in 3D. This usually provides a good
starting point for further refinement.

> Use the Smooth Interior Controls command from the Markers
menu

> Save the design as MyFirstDesign.msd

Modelling Internal Control Points — Procedures — Body Plan View

Body Plan

There are a couple of things you have to learn before we can model the internal
surface in Body plan view.

% Lesson 1: From this moment onwards you should no longer modify the
corner or edge control points; you have already shaped these points in the
previous stages. Note that all of the points in the aft most and forward most
columns are either edge or corner control points so do not touch those!
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http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/modelling-internal-control-points#sZ6JJsRfKn1YeoJ1FPY_9Q
TrainingVideos/StartingADesign4P.avi

EH Body Plan BE&E

.
use the control box

to switch columns
edge contrel point

edge control peint
++ 3.971 $ 7979 Yy 417° W 12.008

Lesson 2: Because the edge control points are fixed, the internal control points a,
b and ¢ can —in general — only be located in the green area unless you want a
“tunnel bottom” (area 2) or tumblehome (area 1). Having said that, as you get
more experienced you will see that areas 1 and 2 sometimes have to be used to
create specific shapes, but for now it is recommended to only use the green area
in the middle.

\3

2

Internal control points should never be positioned in
areas 3 and 4.

Lesson 3: Moving internal control points does not influence the shape of the
edge of the surface.

Tips:
o Ingeneral: Always try to minimise the amount of data (Contour lines,
Markers, Control points etc.) displayed on your screen.
o When you are working in body plan view it is easiest to work at one
column at a time. It is important however to realise that the 3D shape of the
vessel results from all columns and rows being fair in 3D. This means that
even though a section might look fair in 2D Body Plan view, this does not
necessarily mean it is fair in 3D. When working in a 2D window, always try
to think about the 3D shape surrounding the area of the 2D section you are

working on.
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o Ina 2D window the movement of a control point is strictly restricted to
movement in the plane of the window. For example: in Body Plan you can

only move control points in the Y-Z plane and movements in the X direction
(Fwd or Aft) is not possible. Movements in the X direction should instead be
done in either the Plan or Profile view. Moving control points in Perspective

view is also possible, but a little more complicated and will be discussed

further on in the training manual.

> Hide the Net

»  Switching between the columns using the control box, position the

control points of each column to shape the internal surface.

There is no particular order you should do this in, but in this tutorial

> Start with the 2™ column from aft and work your way towards the

bow

» You can use your own creativity for the position of the internal
control points, or use the suggested locations in the table below:

Internal Suggested location

Control point

a Directly below deck edge for vertical walled
hull/deck

b Drag outwards for more voluminous hull

c Same height as centreline edge control point for
smooth transition across centreline

\7

7
.

N

[5]

NG

> Switch to Plan view to check your adjustments

Modelling Internal Control Points — Procedures — Plan or Profile View

Plan view or Profile view

After you have roughly positioned the control points in Body Plan view, check

the position of the control points in Plan and Profile view.

Show the Net

Before you made changes in Body Plan it looked like this:

[
L}
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It may now look more like this:

Boats usually don’t get built with zigzags in the hullshape, so try to avoid these
zigzags in the control point net as well:

—t—7

Instead of zigzags, try looking for “bananas”: smooth curves.
Do the same in Profile view

:

1 [ f

E

Continue to make adjustments where necessary. Your aim should be to make all
control points rows and columns “flow” in smooth lines, remembering that a
smooth control point net results in a smooth surface.

% Shaping the internal surface is a highly iterative process. Switching between
columns in Body Plan view and switching to the other view windows often, will
slowly make the design fairer. This fairing takes some experience and will be
discussed later in the training material.

Modelling Internal Control Points — Procedures — Perspective View

Perspective view

By rotating the model whilst showing the Net, all irregularities in the control
point net become visible.

Making adjustments to the control points net in Perspective view is not
recommended for inexperienced users.

The perspective window can also be used to find and select a control point that is
difficult to select in one of the 2D view windows because it is hidden by other
control points. In Perspective view you can rotate the model and find and select
the control point you need. A selected control point in any view window in
Maxsurf will also be selected in the other windows. For example:

71



In case you want to select this control point in Profile view..

But in Perspective view it is easy to find it and select it ...

—_—

And in Profile view the control point is selected as well.

> Show the Net

» Check the control point net in the Perspective window by rotating
the model

A minor zigzag can be seen in perspective view at particular orientation angles.
Generally you will want to investigate this and fix it in the 2D view windows.
You will learn more about this in the basic fairing section of this training
manual.

Don’t spend too much time on the internal control points at this stage. When you
are done with the model you can lock the surface from Surfaces | Locking:

Locked Surfaces &
Locked Sufaces Lock &l
J%Hull Unlock Al
Cancel
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» Go Surfaces | Locking and place a tick next to the Hull surface.

You can also use Right click on the surface in the Assembly Pane, or use the
Surface Properties dialog to lock the surface. Locking the surface will lock and
hide all control points, preventing any unintended changes.

» Save your design as MyFirstDesign.msd

Congratulations! You have created your first design by starting a new design and
inserting and modifying a surface from the Maxsurf surface library. The next
section in this training manual will take you through an alternative option to
starting a design: Modifying an Existing Design.

Modifying an Existing Design

Previously you have learnt how to model a design from scratch by inserting a
pre-defined surface from Maxsurf’s surfaces list and then modifying it.

As mentioned earlier in this training manual, there are different options to start a
new design and you can — as an alternative to starting completely from scratch —
start a new design by changing an existing design from the Maxsurf Sample
Designs library. With an extensive collection of designs from small yachts to
container ships, you are likely to find an existing design that you can modify to
produce the design you have in mind.

Let’s first have a look at a few of the sample designs that get installed with
Maxsurf before we continue and look at some tools to make modifications to an
existing design.

Start with the section on Exploring Sample Designs Directory.

Exploring Sample Designs Directory

> Inwindows explorer, navigate to c:\program files\Maxsurf ##,
where ## is the version number.

Depending on which Maxsurf applications you have installed, you will see
something like this:
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& Maxsurf FE®E

© File Edt View Favortes Tools Help i 'r
@ Back - \_J l.@ /“ ) search i Folders -
: Address |[h CtiProgram Files|Maxsurf V| o
Size M
File and Folder Tasks
() Make a new Folder
@ E\;L'I:iliSh this folder to the ) HMCriteriaHelp ]
w Share this Folder [ HMSpecificCriteria
[CLibraries
[CD)Reference Designs 2
Other Places [DSample Designs 3
() Sample Modeling Features 4
[ Program Files L3 Training Samples 5
My Documents Utilities
§ My Computer DelsL.isu 20 KB
~— LJ"ﬂ GOIPus. DLL 1,607 KB
l:J My Metwark Places
T HLManual pdf 6 655 KB
[ HMAutomation, chm 173 KB
Details T HMManual, pof 12,296 KB
HMSettings. xml 5KEB
[ HAutomation.chm 45 KB
2 HsManual.odf z.447KB ¥
< | >
&5 obijects 159 MB 4 My Computer

The following items in this folder are worth mentioning at this stage:

1.

>

Automation Samples are for the advanced users only and contain for
example sample spreadsheets with Macros that drive Maxsurf or other
applications of the Maxsurf suite from the spreadsheet.

Reference Designs are designs that have been used to benchmark some
of our analysis software like Seakeeper.

Sample Designs contains a library of different samples. We will have a
closer look at this folder below.

Sample Modelling Features folder contains parts of a ship that have been
modelled a specific way; for example a propeller or the stern of a ship.
Training Samples folder contains all samples that are used in training
documents.

A long list of files containing the manuals, applications, libraries,
supporting DLLs etc. Don’t ever change anything to this list unless you
know what you are doing!

Open the Sample Designs Directory

Depending on which Maxsurf applications you have installed you’ll see
something like this:
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& Sample Designs

File

Other Places

=) Mazxsurf

Edit Wiew Faworites Toaols  Help
? - 6 @ L
@ Back > l.@ 7~ search || Folders
: Address |E:| CHProgram FilesiMaxsurfySampla Designs A | G0
Size Type
File and Folder Tasks E}F } File Folde
: rulkibull Filz Fald
(2 Make a new Folder Qmutehuls ?e o108
- o () maval File Foldd
@ E\';'EQSh this Folder to the () Poweryachts File: Folde
Ea:? chare this folder |5) Sailingachts File Folde
[5) Ships File Folde
() Workboats File Folde
Bz Hullspeed Sample_Workboat, hsd T 1 KB HSDFile
Hullspeed Sample_wWorkboat, msd 4KE M3D File
m Hydromax Sample_IMOcriteria, hor 41 KB HCR File
@ My Documents Hydromax Sample_‘workboat,hmd 473KE  HMD File
:i Py @i Hvdromax Sample_‘Waorkboat. rmsd 22 KB MSD File
- MaxsurF Sample_Trawler.msd 14KE M3D Fil=
\:J Iy Metwork Places : )
By Prefit Sample_Patrolvessel.pfd 3KE PFD File
Seakeeper Sample.rmsd 74 KE M3D File
Seakeeper Sample.skd SKE SkDFile
] span Sample_IMSYacht msd 19KE MsD File
Span Sample_IMSYacht,spd 1KB 5PDFile
Workshop Sample_workboat, msd Z1 KB 3D File
@Workshop Sample_workboat,wsd 1,111 KB 'WSD File
< ¥
1,73 MB J My Computer

20 objects

1. All samples in the Sample Designs directory have been sorted by ship

type.

2. This list consists of several sample designs; one for each application of

the Maxsurf suite.

Some examples:

Catamaran Ferry
Shows a complex surface topology
specific to catamarans.

Wave piercing catamaran
Another example of complex surface
topology for a catamaran. This
wavepiercer has an integrated

superstructure.

=
&
g

Patrol vessel

The hull of this model shows a good
distribution of control points and is faired
very nicely. The decks and keel trim the
hull.

Motor yacht

This model features numerous bonded as
well as trimmed surfaces. There is a video
on the website that shows the different
techniques used to model this vessel. This
video is only available to users of Maxsurf
with current subscription.
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Fast yacht

This model uses numerous trimming
surfaces and consists of NACA keel (incl.
bulb) and rudder and has a cockpit and
coach roof. Good starting point for any
sailing yacht.

Container ship

This model shows a surface topology that
can be used for large ships such as
containerships with flat of sides, bowcone,
stern bulb and bulbous bow. Uses a
trimmed deck / sheer line.

Anchor handling vessel

This simple looking hull can be used as a

starting point for many workboats such as
OSVs, tugs etc. The model features many
bonded surfaces allowing each surface to

be developed separately to minimise plate
forming production cost.

Workboat

There are several workboats in the sample
design library; each one with different
number of surfaces and features. This one
uses bonded surfaces and consists of a
bowcone, topsides, bottom and chine.
Good starting point for crew boats but also
some open deck fishing vessels.

Now it is time to learn how to make Simple modifications.

Simple modifications

Simple modifications — Concepts

Let’s face it: most ships all look the same. This means that in most cases it is
possible to take an existing design and, for example by simply resizing it, get
reasonably close to a customer’s requirements. In Maxsurf, resizing and/or a
simple parametric transformation (eg increasing the displacement) can all be
done without touching control points. This means that if you for example have a
fair design that was built 30 m long with a displacement of 44 tonnes you can
have a 35 m ship with a displacement of for example 54 tonnes in a matter of
minutes. And even better: the fairness quality of the surface model will be
maintained during the modification.

Simple Modifications — Video

& Watch a short video that shows you how to resize the trawler sample design
and apply a simple parametric transformation on your own MyFirstDesign file:
increasing the displacement whilst keeping the draft the same. [Web | Disk]
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Simple Modifications — Procedures - Resizing

Resizing

To modify an existing design, you will first need to unlock the relevant
surface(s) that you wish to make modifications to. We will return to the sample
trawler model as it is a simple single-surface model.

> Close any currently open design by going to File | Close Design.
» Select Open from the File menu.

» Navigate to the Maxsurf program file directory (C:\Program
Files\Maxsurf\Sample Designs

» Open the design called Maxsurf Sample_Trawler.msd.
» Display the Sections and the Grid

To modify the design in any way, the applicable surface(s) have to be unlocked.
If a surface is locked, its control points cannot be moved and are hidden.

> Go to Surfaces | Locking

Locked Surfaces &)

Locked Sufaces Lock &l
J Hul Unlock Al

Cancel

» Remove the tick next to the Hull surface by clicking it with the left
mouse button.

Note: you can also resize the surfaces using right clicking in the Assembly Pane.

Suppose we wish to resize the trawler from an overall length of approximately
45 m down to 25 m.

» Go to Surfaces | Size Surfaces
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Size Surfaces )

Surfaces: Proportional

J Scaling
Hull

I 105617 m i‘ Beam
[ [8B4m i‘ Depth

[ re-zcale markers

Cancel

When resizing a surface, it is necessary to decide which, if any, of the
dimensions should be scaled proportionately. Use this proportional scaling if you
have a basis design of which you wish to maintain the beam:depth ratio,
length:depth ratio and/or length:beam ratio. To scale two or more dimensions
proportionately, place a tick next to the items that should remain in proportion.
For example, to maintain length:beam ratio, place a tick in the proportional
scaling boxes of length and beam; if you would like to keep all dimensions in
proportion, place a tick in all three boxes.

» Place atick in all three proportional scaling boxes.
» Enter 25m for Length.

Observe how the beam and depth values automatically update to maintain the
L/B and L/D ratio.

> Click OK.

Simple Modifications — Procedures — Parametric Transformations

Parametric Transformations

Please read the Using Parametric Transformations topic from the Manual (it is
only necessary to read up to the Parametric Transformations Restrictions
heading. Example exercises do not need to be performed).

> Open your own MyFirstDesign.msd file.

Alternatively, you can open a copy of the file from the C:\Program
Files\Maxsurf\Training Samples directory.

> Save the design as MyFirstDesign_transformed.msd

It is generally good practice to save to another filename before doing a
parametric transformation or working with the standard sample designs.

» Go to Data | Parametric transformation
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Parametric Transformation

[ Parallel midbody

Aft midbody limit Om Forward midbody limit (0 m
Search For
(™ Block Coefficiznt 587 LCE aftof FP |57.66 % Dwil
(+ Prismatic Coefficient 076 - A7.3 % DL
[v Midship Area Cosfficient 0.78 [ Topside Flare 0.02 Degrees
- 0.805
Scale To:
[ Dizplacement 0028t v Beam [9.484m
v ‘waterine Length  [41.306 m v Duaft  |2971m Cancel

» Tick the Displacement and Draft boxes

>
other values as they are.

Change the displacement to 110% of the current value. Leave all

This will search for an increased displacement by varying the Lwl and Beam, but

keeping the Draft the same. If you used the supplied MyFirstDesign.msd from

the C:\Program Files\Maxsurf\Training Samples directory, the Scale To box

should appear as follows:

Scale To:
v Dizplacement 7Ot [~ Beam [3.484m
[~ Waterine Length 41,306 m [w Draft |2971m

» Press Search and wait for the hourglass to disappear

Note that the waterline length and beam have both increased and that the
increase in length is reflected in the profile view of the model in the
dialog.

Scale T
[v Displacement FiOt [~ Beam [9.945m
[~ ‘Waterline Length  [43.313m v Draft |29 m

» Press OK to accept the new hullshape

‘Immersed depth’ is equivalent to the draft in the parametric
transformation dialog; ‘Lwl’ denotes waterline length and ‘Beam
wl’ the waterline beam (the maximum width of the waterplane).
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» Go to profile view and do a Ctrl+Z to undo the parametric
transformation and a Ctrl+Y to redo it. This quickly gives you an
idea of the changes.

> Resave the transformed model.

Continue with the section Other Options to Start a New Design.

Other Options to Start a New Design

% Previously you have learnt that you can start a project by starting from
scratch or by using an existing design and modify this to match design
requirements. Generally, the naval architect is confronted with a variety of
projects with different combinations of input data and output requirements. For
example: a customer only provides paper drawings of a ship and needs to have
the stability booklet re-issued after a modification to one of the tanks. This
means that a Maxsurf model has to be created so that this can be used in
Hydromax for Hydrostatic analysis. Another example may be that the customer
has a DXF CAD drawing and wants to build a similar ship with minor
modifications to the sheerline. In this case a Maxsurf model has to be setup in
such a way that the surface model is useful in Workshop to expand plates, define
stiffeners and frames and other primary construction parts. Both examples above
have different input data and require very different surface models to deliver
output that satisfies quality standards. Deciding the most cost effective way to
handle the examples above requires a fair amount of experience and is thus not
within the scope of this training manual. Extensive documentation on this topic
is available to users with current subscription.

Continue with the next section where you will learn some Chapter 6 Basic
fairing techniques and concepts.
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Chapter 6 Basic fairing

In this tutorial you will learn some background information on surface fairing
and how several display and fairing tools in Maxsurf can be used to help you
obtain a fair design.

Start by reading the section on the Fairing Concept.

Fairing Concept

% To really understand the concept of fairing surfaces it may be helpful to look
at how lines fairing was done historically. The draftsman would use a rod (or:
batten), bend it and place weights on it to fix its shape. The more curvature was
needed, the more weights were needed to hold the rod in position or a more
flexible rod had to be chosen. Adding more weights on top of the rod, would also
make it easier for unfairness (i.e. inflexions in the curve) to arise. To prevent
that, the draftsman would lift each weight up, let the rod “relax” and put the
weight down again. With this procedure, he would iterate to obtain the required
shape. Instead of adding more weight to areas of high curvature, the draftsman
could also choose to use a rod with less stiffness. The disadvantage of that is that
the flexible rod would make it very difficult to fair parts of the curve with less
curvature. Ultimately, the experienced draftsman would look for the stiffest rod
and use as few weights as possible to obtain the required shape.

In Maxsurf, a B-spline surface can be seen as the rod and the control points as
the weights. (See Chapter 2 of the Maxsurf manual on the Basic Principles).

Start learning fairing in Maxsurf in the section on Displaying Curvature.

Displaying Curvature

Maxsurf has a range of tools to display curvature on curves or contours (eg a
buttock) as well as on surfaces.

In this section of the training manual you will learn the different display tools
and also get a feel what makes a line/surface fair or unfair by manually removing
control points from a curve or adjusting their position. In the next section you
will then learn different tools and techniques that Maxsurf offers to assist you
improve fairness.

Start with the section on Display Curvature on a Curve or Contour.
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Display Curvature on a Curve or Contour

Display Curvature — Concepts

In this section we will look at some tools to display the curvature on curves and
surfaces. We will go through a number of steps displaying the curvature on a
curve and making simple modifications to the curve to improve the fairness.

» In Maxsurf, go to the Profile view window

» Open the BasicFairingSpline_Start.msd file

You will see something like this:
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You can see that the left side of the curve only contains a few control points,
while the right side has the control points much more densely spaced. A lot of
the control points on the right can be removed without changing the shape of the
curve while improving the fairness of the curve. But how do you actually judge
the fairness of this curve? This is where you need some display tools like
Curvature porcupines and compress.

Display Curvature — Video

#= View a video that will show you the different curvature display tools for
curves such as Curvature porcupines and Compress view. The video will also
show some steps to manually improve the fairness of this curve. [Web | Disk]

Display Curvature — Procedures - Properties

Curvature Porcupines
The curvature on contours may be displayed in the form of porcupines.

> Select the spline curve

n = =l

o [% - == NS
Bep.

» Now select Show Curvature from the Display | Curvature menu or
using the toolbar button below:

i
~N

You will see something like this:

r-r/\\v/—r—"\—//ﬂmwj _\LEW?__:

> Read about curvature porcupines in the Maxsurf manual.
% Note: The value of the smallest radius (tightest bend) on a given curve is

displayed numerically at the end of the porcupine located at the corresponding
position on the curve.
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http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/displaying-curvature-on-a-curve#0126D1r-Ll0MDvNFJ8c_CQ
TrainingVideos/DisplayAndImproveFairnessOnCurveP.avi

You can also see that the curvature porcupines change sides from the upper to
the lower side of the curve. This means that the curvature direction changes from
positive to negative or visa versa. Changing of the curvature direction may be
classified as an inflection. There are a number of inflections in this curve:

AT Ly, /2
s

Inflection 1 may be classified as unfairness, whilst inflection 2 may be a feature
of this curve.

a

> Increase the longitudinal stiffness of the curve from 3 to 4 using
the Surface Properties dialog from the Surfaces menu.

By increasing the stiffness the curvature discontinuity is

reduced.

> Remove one control point from the inflection area

Controls > X

BT ALY

» Space the control points in the area so that they are evenly
distributed by moving the middle control point as shown below.

» Adjust the height of the middle control point to remove the
inflection and produce a continuous curvature along the curve in
this area.

You should now see something like this:
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The surface fairness can be improved by increasing the

surface stiffness, removing control points and spacing
the control points evenly.

E42Tm

RN P

» Now continue removing control points nr 4, 6, 8 and 9

This again leads to a dramatic improvement of the fairness. See
BasicFairingSpline_EndCurvature.msd file.

You should use the stiffest spline and minimum number

of control points that will give the desired shape.

Now let’s use the compress curvature display tool to further improve the fairness
of this curve.

Display Curvature — Procedures - Compress

Compress

This expands the transverse and vertical axes in relation to the longitudinal axis
in the plan and profile views. This can be helpful when fairing long, slender
hulls.

» In Maxsurf Profile window, open
BasicFairingSpline_EndCurvature.msd

> Select Compress from the Display menu

We can now see that the fairness can be further improved by distributing the
amount of curvature along the length of the curve better so that we end up with
something like this:

1207
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ﬁ Exercise: Try fairing the curve by using the compressed view to produce a
curvature distribution similar to the one above.
A few pointers:

» Whatever you do, don’t touch the corner control points (1 and 9)!

» Distribute the control points evenly long the curve, with a steadily
reduced space between the control points on the right side of the
curve

» Move the control points up and down in small increments

Tip: you can use the arrow keys of your keyboard to move a control point up and
down 1 mm at a time.

3612

Continue with the Display the Curvature on a Surface section.

Display the Curvature on a Surface

Surface Rendering — Concepts

You can colour shade or render a surface to display the shape and curvature.
Maxsurf has different rendering types available. Each rendering type can be used
for different purposes.

See the Maxsurf manual section on Rendering a surface for more information on
the different rending options.

We will explore the following surface rendering options:
e Simple Shading
e Smooth Shading
e Longitudinal curvature

e Transverse curvature

The other rendering options you will see in the Rendering dialog are not useful
to display the fairness of the surface and will not be discussed in the Learning
Maxsurf training manual.

Surface Rendering — Video

# View a video that will show you the different rendering options in Maxsurf.
[Web | Disk]

Surface Rendering — Procedures

Surfaces can only be rendered in the Perspective window.

85
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TrainingVideos/SurfaceRenderingP.avi

» In Maxsurf, switch to the Perspective View window
» Open the BasicFairing_SurfaceRender.msd file

Depending on which contours you have displayed, you should see something
like this:
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> Select Display | Render and select the Simple Shading option from
the Rendering Selection dialog:

Rendering Selection

¥ Hidden Surface Elimination
{* Simple shading
™ Smooth shading

[ Show suface contaurs

-
™ Gawssian Curvature I

" Longitudinal Curyvature

" Transverse Curvature
" Corveesity

Cancel

¥ DpenGL Hardware Acceleration

You should now see something like this:
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Simple shading

Note that even though it provides you with good information about the 3D shape,
this is not very useful to evaluate the curvature or fairness of the design. Let’s try
the next rendering option.

» Switch to Smooth Shading in the Rendering Selection dialog
You will now see something like this:
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Smooth shading, black surface colour

This is a lot more useful display to visualise the curvature. Use the slider bars
and/or free rotate buttons of the Perspective window to rotate the model and look
closely at the light reflecting off this surface. This gives you immediate feedback
if there are any lumps or inflections. We can do better though:

» From the Surfaces | Surface Properties, change the colour of the
surface to gold by double clicking in the “appearance” square which
brings up the colour picker dialog.

Surface Properties

Geometry;

Surface Tope: Surface Mame:
* B-zpline
 MUFE Wigwing and 4 .
£ Conic Suiface Flal Basic colors:
™ Developable :E viibl= | IR T [

v Locke
Surface stiffness: ¥ Symme HTETENN
Transverse: ¥ Spit 5e EEEEEEEE
4 - . ENEEEEEN

PREar At
Longitudinal - - - - - - - -
3Mfexbls] v IEIIIII_II_ «
Surface Use: Tranzparen -
* Hull Shell

1]
™ Internal Structure Hue: |40 Fed: (128

T rrrrrir
Sat: |240 Green: |128
| ColorSolid |\ [60 Blue: |0
Ok, | Cancel | Add ta Custom Colars |

Now the surface looks something like this:
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Smooth shading, gold surface colour

This is again a lot more useful to visualise any unfairness. The gold colour of the
surface reflects a lot more light than the black colour.
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Some colours are better than others to visualise surface

curvature.

> Inrendered mode, you can switch lights on/off. Experiment with
switching lights on/off. Ignore the button with the hand icon on the
far right.

> Finally, set them as in the image below:
Qv |« |* =&,

» Again rotate the model in Perspective view so that you get
something like this:

E1 Perspective
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By rotating the model and switching lights on/off we have visualised an areas
with discontinuous curvature. Let’s have a look at the actual curvature of the
surface in this area now:

> In the Rendering Selection dialog, select Longitudinal Curvature

£ Perspective EE&E
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Longitudinal curvature rendering

%As you may have read in the Maxsurf manual, the green areas have zero
curvature (read: run along a straight line in longitudinal direction) and — if the
surface normal has been setup correctly — the blue areas are positive curvature
(convex) and the red areas are negative (concave).

What you are looking for are the transitions between for example green and blue
or red. Where the colour changes rapidly, there is a rapid change in curvature
which usually means unfairness. Changes from blue into red without any green
in between are generally undesirable.
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Rapid transition from Green into Blue A more blurry transition between
Blue and Green

Finally let’s have a look at the transverse curvature:

> Switch to Transverse Curvature in the Rendering Selection dialog

£51 Perspective
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Transverse curvature rendering

Notice that this does not show the same areas of green, blue and red. This is
because we are now looking ONLY at the curvature in the longitudinal direction.
What is clearly visible with this rendering on this model is the transition from the
flat of sides to the bilge radius. It is debatable whether — in this case — this is
unfairness or a feature of the design.

45 Exercise:

» Switch rendering off by clicking on this toolbar button:

@)vi<|* =&,
» Switch all contours off except for Edges and Sections
» Select one of the sections in the midship
> Select Display | Curvature | Show Curvature
This looks a bit messy! Let’s scale down the curvature porcupines

» Select Edit | Preferences and set the Curvature Porcupine size to
5%:
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Using a combination of renderings and curvature

porcupines you can get a good understanding of the
curvature of the surface.

This completes the section on displaying fairness on a curve or surface. Now
let’s have a look at some basic fairing tools in Maxsurf that help you adjust the
fairness of a design.

Next: Basic Fairing Tools & Techniques.

Basic Fairing Tools & Techniques

In this section we will use different fairing display techniques from the previous
section and learn how to use simple fairing tools to make improvements to a
curve (eg an edge of surface) and surfaces or parts of a surface.
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Continue with Straightening Control Points.

Straightening Control Points

Straightening Control Points — Concepts

Maxsurf has a straightening tool that will straighten:
1. all control points on a row or column between two selected control
points on the same row or column:

[ ]
2. all control points on a surface patch defined by two diagonally
opposite selected control points:

.

This straightening can be done either:

1. From the current view direction. You will only see the control points
on a straight line from the current view direction, but they will not be
straightened from the other view directions.

2. In 3D. The control points will be straightened in 3D; regardless what
view direction you are looking from.

In the procedures below you will learn how this command can be used for
specific purposes as well as its side effects.

Straightening Control Points — Video

# View a video that shows you how to use the straighten command to
straighten control points on the deck edge of a containership followed by
straightening the Flat of Sides area of the hull. [Web | Disk]

Straightening Control Points — Procedures — Row or Column

Straightening a row or column
> Open the BasicFairing_FairingToolsStart.msd in profile view
> Hide the Control point net
»  Switch the Compress display on

You should now see something like this:
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Notice how the compress display suddenly shows that the top edge of the surface
is not a straight line whereas in normal view this was difficult to see.
Let’s straighten this top edge:

» Select the aft corner control point

» While holding the Ctrl or Shift key down, select the top edge
control point located at 68.5 m fwd of Aft Perpendicular (column 9)

> Use the Controls | Straighten Controls | In Current Plane only
command.

EH Profile
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@ This results in a movement of the control points that lie between the two
selected control points (A and B) in the direction perpendicular to a straight line
connecting A and B onto that straight line. This straight line can be straight in 3
dimensions or a straight line from the current view direction only.

To straighten just one row or column, A and B have to be on the same row or
column respectively.

> Now switch to Plan view

> Notice how this deck edge is not straight in this view direction

We can fix this by repeating the command above for this view direction, or using
a straighten command in 3D.

» Undo the straighten command by using Ctrl+Z or reloading the
design from the start of this section.

» Inplan view, select the Aft corner control point (A) and the edge
control point at 68.5 m fwd of Aft Perpendicular (column 9) (B)
again.
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» Use Controls | Straighten | In Three Dimensions

Notice how this has straightened all controls points between A and B in both
Plan view as well as in Profile view. When you use Straighten in Three
Dimensions, it does not matter which view window you are in as opposed to
when using Straighten in Current Plane which only straightens in one direction.

Straightening Control Points — Procedures — Surface Patch

Straightening a Surface Patch
The previous section you learnt how to straighten a row or column of control
points

> Continue with the model from the previous section, or open the
BasicFairing_FairingToolsBowStraight.msd

» Switch to Perspective view
> Use the Transverse Curvature rendering

> Rotate the model so that you see something like in the image on
the left:

£51 Perspective

£3i Perspective
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You can see that there is a transition from red into blue without any green in
between at about midship. This should be the flat of sides (FOS) and thus
coloured green (green = no curvature = flat). We can use a straighten command
to straighten this panel. First let’s see how the straighten command works on
panels, by making a “mistake”.

> Switch rendering off and zoom in to the bow area
> Switch the net on

> Select the bow corner control point and a control point in the
middle of the bow area like below:
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» Use the straighten in three dimensions command

You’ll see something like this:
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This model can be viewed by opening BasicFairing_FairingToolsBowStraightEnd.msd

% In the background, Maxsurf has done the following steps:
Step 1:

The area that the straighten command is applied on is determined from the
selected control points. This can be called a patch of control points:
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Step 2:

All four corner points of this patch are fixed in space and will not move. Patches
selected by selecting two points on the Net are always four-sided and have four
corner control points.

Step 3:

The edge control points are straightened between the corner points*
Step 4:

The internal control points are straightened between the edge points*
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*same as for straightening a row or column, this can be done either in three
dimensions or in the current plane only. The current plane in Perspective view is
determined by the orientation of the model. In the bottom right hand corner of
the Perspective window, there is a little orientation icon that indicates the current
working plane. It is important to rotate the model in such a way that you have the
correct current working plane when using the “Straighten in Current Plane Only”
command as it will affect in which direction the control points are straightened.
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The orientation icon indicates that the current The orientation icon indicates that the current
working plane is Body Plan view. working plane is Profile view.

Now let’s use what we have learnt so far to straighten the flat of sides panel:

> Undo the last straighten command so that you get your regular
bow shape back or load the
BasicFairing_FairingToolsFOSStraight.msd file.

First we have to determine which control points we have to select in order to get
a straight patch.

» Switch transverse curvature rendering on and zoom in so that you
can see the stern and midship.

£ Perspective

j Fe
-180

Remembering what Maxsurf does in the background when straightening a patch
of control points in step 2 (fixing the corner control points), it is important to
know the location of the corner control points before using the straighten
command:

» Double click on all corner points of the patch as in the image
above: A, AB, B and BA. Notice that they are all offset from the
centreline by 9 m. This means that all four corner points are planar
which is what we want for this flat of sides panel.

95



»  Switch rendering off in order to select the patch corner points A
and B

> Apply the Straighten in Three Dimensions:

£51 Perspective
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We clearly see the flat of sides appearing after applying a straighten command

Notice how the shape of the control point net that forms the bilge-FOS line (from
AB to B) has now become a straight line. This is not what we want.

» Undo the straighten command

> Rotate the model similar to the image below and switch rendering
off

» Selecting the same patch as before, now use a Straighten In
Current Plane Only command:

120)
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This model can be viewed by opening BasicFairing_FairingToolsFOSStraightEnd.msd

You can see how the Straighten in current plane command maintains the shape
of the Bilge — FOS line. This is because, when you rotated the model to the
orientation as in the image, the current working plane was set to Body Plan.

» Read the text directly below step 4 (above) again
» Undo the change you just made

> Rotate the model around the “Yaw” axis so that the orientation
icon indicates that Profile view is the current working plane:
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The orientation icon indicates that the current The orientation icon indicates that the current
working plane is Body Plan view. working plane is Profile view.

» Now repeat the Straighten in Current Plane only command on the
same control points A and B as before.

> Notice how the Bilge — FOS lines is now a straight line and the
transverse curvature transition is still there:
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%Although this is complicated to understand - and it is not expected that you
do at this stage of the training -, perhaps the following images help you
understand why the result of a Straighten in Current Plane is different when the
current working plane is Body Plan view or when it is Profile view:

E Profile EIE)E

++ O1.146 31 ¥y 08" W 91.185

When the current working plane is Profile view, the control points between the corner points of the
patch (in this case between AB and B) will move onto the straight line — as seen from Profile view -
between AB and B perpendicularly.
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Whereas, when the current working plane is set to Body Plan view, the control points snap to a
straight line as seen from Body plan view and — in this case because all four corners were at 9 m
offset from the centreline and the straight line is thus vertical — the control points all move horizontally
inwards and outwards.

In case after reading the above, you still don’t understand (which is OK) just
remember that:

e You can use a Straighten command in Three dimensions and in the
Current Plane only.

e When you use the Straighten command in Current Plane only, the current
working plane determines the outcome of the result.
If the result is not like you expected it you may want to try using another
working plane by switching window, or rotating the model in Perspective view.

= You may wish to repeat this tutorial a couple of times to work your way
towards fully understanding this command.

Continue with the section on Smooth Control .

Smooth Control Points

Smoothen Control Points — Concepts

Smooth control points works exactly the same as straighten controls, except now
instead of straightening the control points Maxsurf now projects the control
points onto a smooth curve or smooth patch. Smooth control points moves the
control points in all directions and cannot be restrained to one working plane.

Smoothen Control Points — Video

69 View a video that demonstrates the use of the Smooth Controls command to
smoothen out the hull surface of a trawler. [Web | Disk]

Smoothen Control Points — Procedures — Smooth Curve

Smoothen a curve
> Open the BasicFairingSpline_Start.msd file in Profile view

98


http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/smoothing-control-points#L7mgfL-al_gRicoLVjsFrg
TrainingVideos/SmoothingControlPointsP.avi

» Switch Compress view on and set your porcupines size to 50%
from the Edit | Preferences dialog.

» Select control points A and B as below

£ Profile

++ 5057 $-0.325 K7y 336.6° 1,355

> Use the Controls | Smooth controls | Flexible

Flexible

> Undo the last command and now use Smooth Controls | Medium
on the same selection of control points:

@ O.m
Medium

> Undo the last command and now use Smooth Controls | Stiff on
the same selection of control points:

i

Stiff

You notice that, especially when you smooth the control points to a Stiff curve,
any irregularities in the curvature (eg inflections) disappear. Now let’s apply this
to a patch of control points.

Smoothen Control Points — Procedures — Surface Patch

Smoothen a surface patch

» Open the BasicFairing_FairingToolsSmoothStart.msd file in
Perspective view
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» Switch on Longitudinal Curvature rendering
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We will use the Smooth Controls command to fair this model.

> Select a fairly large patch by selecting control points A and B as

shows below:
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» Use a Smooth Controls | Medium and render the model:
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Longitudinal curvature rendering after a smooth control points

It is very difficult to explain and/or learn how the smooth control points
command works. Best way to learn about this command is by trial and error;
aided by the following tips:
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e The larger the number of control points in the selection the better

e Use medium first and evaluate the result. Use Stiff in case you need more
drastic correction or use Flexible if Medium changed the model too much.

e Stiff, Medium and Flexible may give the same result depending on the
surface stiffness and the number of selected control points.

e You cannot use the smooth command on a selection with only 3 control
points

e Good results can be obtained by using overlapping patches:
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This is an example only, individual patches would have to be bigger for good results

e Switching between smoothing just one row or column and smoothing a
patch can give good results

e Best results can be achieved when all of the above is used in combination
with manual control point movements.

Exercise:

>  With the model from this section, experiment using the Smooth
Control Points command.

» Use what you have learnt so far to fair your design that you
created yourself “from scratch” earlier on in this training manual.

Continue reading the Control point net & surface stiffness guidelines section.

Control point net & surface stiffness guidelines

% From what we have learnt in the prior sections we can extract a few fairing
guidelines. These are outlined in the following paragraphs.

Start with reading Surface stiffness guidelines.

Surface stiffness guidelines

As has been demonstrated in the Surface Stiffness tutorial, the spline stiffness (or
order) has a considerable effect on the surface's curvature. Ideally you should
have reasonable curvature continuity and smoothness along the contours. The
curvature can be made smoother by increasing the stiffness. This is illustrated in
the images below:
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Stiffness = 2 (linear): Continuous position, discrete slope, zero curvature.
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Stiffness = 3 (Flexible ): Continuous position and slope, discrete curvature.
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Stiffness = 4: Continuous position, slope and curvature, discrete change of curvature.
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Stiffness = 5: Continuous position, slope, curvature and change of curvature.
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Stiffness = 6 (Stiff): Smoothest curvature plot, surface is continuous to 4" derivative.

Because ships generally have more curvature in transversely than longitudinally,
the longitudinal stiffness can be higher than the transverse stiffness. Experience
shows that good models usually use longitudinal stiffness 4 — 6 and transverse
stiffness 3 — 5, where unfair models use lower stiffness eg: longitudinal 3-4 and
transverse 3.

Use the stiffest surface that allows you to achieve the

desired shape.

Continue reading Number of control points.

Number of control points

The number of control points along a spline determines the amount of control
you have over the surface shape. In the same way that the spline’s numerical
stiffness reflects the stiffness of the physical fairing rod, the number of control
points is equivalent in a physical sense with the number of weights that are used
to hold the rod in place. The more weights you use in one particular area of the
rod, the more control you have over its shape. At the same time it is much more
difficult to achieve a smooth curve without any unintended inflections in areas
with a lot of weights.

Use the minimum number of control points that allows

you to achieve a desired shape.

Continue reading Fair Net Equals Fair Surface.

Fair Net Equals Fair Surface

When looking at the control point net in perspective view and rotating the model,
one can immediately recognise a fair design. There are some important
guidelines to keep in mind when modelling a surface regarding control point net
fairness:
1. You should always aim to have a regular and “fair” net. The net
amplifies errors in the surface; the surface is always more fair than the
net.
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The advantage of using NURB surfaces in general is that even when the control points are very
unfair, the resulting surface is always fairer; especially for high stiffness surfaces.

2. The rows and columns should not overlap as this makes further fairing of
the surface much more difficult.

Overlapping columns in plan view

3. One area that is often overlooked when using Maxsurf to design a hull is
the longitudinal spacing of the columns in the net. It is possible to create
hard corners in Maxsurf by moving several control points close together
and this characteristic is commonly used to create chines and knuckles in
a design. A side effect of this is that if the columns of control points in a
design are irregularly spaced the surface can show irregular rates of
change of curvature. In general, try to make sure that the columns of
control points in a surface change their spacing smoothly.

Poor column spacing

Good column spacing
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4. Itis helpful if the rows and columns are near orthogonal, it is especially
beneficial to try to keep the columns as vertical as possible since this
makes manipulation in the body plan view much simpler.

i\

Vertical columns Columns
sloping
forward

Recommended control point net in Profile view

I

e
o

Vertical columns Curved
columns

Recommended control point net in Plan view. Often it can be recommended for the curved columns
to be approximately orthogonal to the centreline as well as to the outer surface edge.

Note that these are guides only and should not be considered rigid constraints
(except that the net should be reasonably regular, and rows and columns should
not cross other rows or columns, though they may become compacted).

Finally, continue reading the Basic Fairing Summary section.

Basic Fairing Summary

An understanding of the historical background to surface fairing can help you
produce fair surfaces in Maxsurf.

Maxsurf has tools to visualise (un)fairness:
e Curvature porcupines, curvature on one or more curves
e Compress, especially useful for long slender hulls

e Rendering, longitudinal and transverse surface curvature

Fairing is mostly a manual process and Maxsurf has tools to help you do that:
e Straighten
e Smooth

e More... these are discussed not discussed in this training manual.

There are several modelling guidelines that will help you achieve a fairer design.
Most importantly:
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e Use the stiffest surface and the minimum number of control points that
allows you to achieve the desired shape.

e The surface is always fairer than the control point net, so make sure your
control point net is nice and regularly and fair.

You have completed the chapter about fairing. Next you will learn about Chapter
7 Modelling Discontinuities.
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Chapter 7 Modelling Discontinuities

In the previous section you learnt how to use several fairing tools that help you
display and adjust the shape of curves or surfaces and reduce any unwanted
inflections, bumps or unwanted discontinuities. In this section we will look at
ways to purposely model modelling discontinuities in a curve or surface.

One can distinguish different types of discontinuities that can exist in a ship’s
hull surface:

Knuckle or chine

A chine that runs along the full length of the ship

A knuckle running along part of the length of the vessel

Deck edge discontinuities

A step up in the deck edge to create a forecastle

Interior surface discontinuities (openings)

An opening in the surface creates a bow thruster.

For each type of discontinuity there are different modelling methods that you can
use:
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e Compacting control points

e Bonding, we will discuss this later but it is basically stitching the surface
edges together.

e Trimming, also discussed later but can best be described as a feature
where you use one surface to cut a portion out of another surface.

Discontinuity Method
type Compacted Control Points | Bonding Trimming
Chines & / / Not recommended
knuckles “ “
Edge cuts Not /
recommended X h

Openings

pening X X v

Go to the section on Compacting Control Points.

Compacting Control Points

Compacting Control Points - Concepts

As you may have already learnt in the previous sections in this training manual,
the closer you move control points together the more rapid the change in
curvature. A discontinuity in a curve or surface can be modelled using this
principle: when certain conditions are satisfied, a knuckle can be created by
moving two control points on top of each other:

- / &\~

—

- / &\~

In this section you will learn how to use compacted control points to model
chines or knuckles in a surface and what conditions have to be satisfied in order
to be able to do this.

Compacting Control Points — Video

#= This video shows how a knuckle can be created in a curve by compacting
control points. This video also shows the advantage of grouping compacted
control points together. [Web | Disk]

Compacting Control Points — Procedures

Compacting Control Points on a spline or curve
First we will use a simple spline to illustrate the effect of compacting control

points.

» Open the CompactCP_Curve_Start.msd design in the Profile

window
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» Switch Data | Precision to highest.
You should see something like below:

/ ™~
=] 3 ‘o

» Move the two middle control points closer together and watch
what happens to the shape of the curve.

Hold down the shift key while dragging. This will restrict the
control point movement to move only horizontally or vertically.

= & m

From this you can see that where the control points are close together a knuckle
is forming, but when you zoom in to that point it is still a smooth transition. Note
that where the curve touches the control point net, both lines are tangential to
each other. Let’s see what happens when you now put the control points directly
on top of each other.

> From the two control points in the middle select the one on the left
first and then the one on the right while holding shift key down.

> Now use the Controls | Compact command (or use the Ctrl+K
shortcut key on your keyboard)

You should see the control point on the right being moved on top of the one on
the left.

The control point that is selected 2" will move on top of
the control point that was selected 1°.

» Click anywhere in the screen to clear the current selection.

> Select the compacted control point by left clicking on it (don’t use
a selection box)
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» Drag it upwards

Notice that the compacted control points —while they shared the same
coordinates - are still being treated as individual points. Often it is convenient to
group a number of compacted control points so that they get treated as one entity
or group. In Maxsurf you can group control points using the Group command:

» Using Ctrl+Z, undo the drag move until both control points are
compacted again.

» Now use a selection box to select both points

» And use Controls | Group or Ctrl + G to group the control points

-----------

> Now try to drag just one control point (you won’t be able to).

You’ll notice that the control points are now treated as one and cannot be moved
separately anymore. You notice that the colour of the control points has changed
to red.

Ctrl + K = Compact control points
Ctrl + G = Grouping control points

Compacting Control Points — Procedures — Over Compacting

Over Compacting
When using compacted control points to model a discontinuity, there is a very
important relationship between compacted control points and surface stiffness.

> Use the curve from the previous steps or the
CompactCP_Curve_Compacted.msd model

> Set Longitudinal curvature from the surface properties for this
curve to 4.

You will now see something like this in Profile view:
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The knuckle in the curve has disappeared after increasing the stiffness to 4.

» Insert a control point just to the left of the grouped control points
(red).

o A a

You’ll see that this situation is very similar to the situation before where the
curve is tangential to the control point net where they touch.

» Select the grouped control points first followed by the newly
inserted control point while holding shift key down

» Ctrl + Kand Ctrl + G to compact and group
2 1 .

o« o =

&

You have now compacted 3 control points on top of each other to create a
knuckle in the curve with a stiffness of 4.

To create a knuckle you need to compact (n-1) control
points where n = surface stiffness.

A

Never compact more control points than (n-1).

For more information on compacted control points, see the Compacted control
points section in the Maxsurf manual.

Compacting Control Points — Video

@ View a video that shows how to model a chine or knuckle line in a surface
by compacting control points. [Web | Disk]

Compacted Control Points — Procedures — Model a Chine

Using Compacted Control Points to Model a Chine

You are now ready to use compacted control points on the design created in the
“Starting a Design from Scratch” section of this training manual and transform it
from a round bilge into a chined hull design.
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» Open the MyFirstDesign.msd file
> Save it as... MyFirstDesign knuckle.msd

> To make it easier to model a knuckle, reduce the transverse
surface stiffness to 3 (this way you only have to compact 2 control
points).

» Switch to body plan view,
> Hide the net, Unlock the surface, Display | Half

> Use the Control box to switch to the aft most column of control
points

» Insert a row control point in the position as displayed in the image
below:

Controls

Controls
AR EY PP Y AE
)
N

» Use a selection box to select the control points that are close
together,

|
C|
C|
=1

» Compact and Group the control points

» Switch to Rendered Perspective view to check your work:
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Knuckle at the transom

» Back in Body Plan view, use the control box to switch to the
column in front of the Aft most column:

. [l [l [l [l 51 t% [l [l [l

> Repeat the select 2> Compact = Group commands for all columns
in the design except for the front most column (we don’t want to
create a knuckle in the bow profile).

> Switch to Plan view and show the Net,

> Display | Contours | Feature lines or use the = toolbar button to
display the knuckle you have just introduced.

E)E)E

Chine | knuckle line
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And in Perspective view:
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» Save your design as MyFirstDesign_Knuckle.msd

— Exercise: insert another knuckle line so that you get something like in the
image below:
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You will see that you have to add an additional 2 rows of control points. Having
so many control points close together in the bow now, makes it quite difficult to
maintain a reasonably fair bow area. Inserting an extra column in the bow may
give you more control over this area:

S
ct\:é-—é%

Extra column

This design is available for download as MyFirstDesign_DoubleKnuckle.msd

Continue with the section on Using Linear Surfaces to Model a Chine.

Using Linear Surfaces to Model a Chine

Linear Surfaces — Concepts

A surface is called linear when the stiffness value is 2.

As we have learnt in a previous section, you can create a knuckle by compacting
(n-1) control points on top of each other when n is the surface stiffness in that
direction. So for example when a surface has transverse stiffness 3, you only
have to compact 2 rows of control points. Similarly, if the surface has a
longitudinal stiffness of 4, you will need to compact 3 columns of control points.
In this section you will quickly learn that when you have a linear surface
(stiffness = 2) you do not need to compact any control points and the surface
simply follows the shape of the control point rows and columns.

Linear Surfaces - Procedures

» Open the MyFirstDesign.msd file
» Save it as MyFirstDesign_Linear.msd

» Switch the transverse stiffness of the hull surface to 2 (linear):

T ————— a
— - ——
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Transverse stiffness 2 surfaces show feature lines

(knuckles) at every row of control points.

> Also switch the longitudinal stiffness to 2:

Completely linear surfaces have knuckle lines at every row and column.

» Save the design

From this you can see that creating knuckles using linear surfaces is very easy.

However, in practice this method is not used often. The reason for this is that a

ship design usually consists of at least some areas with curvature which can not
be achieved with linear surfaces.

Continue reading the section on When Not to Use Compacted Control Points.

When Not to Use Compacted Control Points

As mentioned at the start of this section on modelling discontinuities, there are
different methods to model discontinuities dependent on which type of
discontinuity you wish to achieve. We have seen that chines and knuckles can be
created easily using compacted control points. In the section on bonding surfaces
we will look into using bonding surfaces to create a knuckle or chine.

Do not use compacted control points to model a discontinuity in a surface edge.
e.g. cut-away sheerline. You can end up with more control points than you really
need which makes fairing very difficult or impossible.

compacted control points

Using compacted control points to model a discontinuity in an
edge results in difficulties achieving a fair hullshape.

This concludes the chapter on modelling discontinuities. Next section is Chapter
8 Trimming Surfaces.
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Chapter 8 Trimming Surfaces

Up to this point we have worked with only one surface at the time. Maxsurf Pro
allows you to insert any number of surfaces. Maxsurf Plus allows the use of up
to 6 surfaces and Maxsurf/T allows 3 surfaces. By combining surfaces, complex
models can be created.

% Before you proceed and use trimming surfaces to make some more
modifications to your design, read the section trimming surfaces from the
Maxsurf manual. From this you should remember:

Trimming — Concepts — Trimming rule

Trimming Rule #1

The trimming rules in the manual are very important. For this section of the
training manual we will only highlight the importance of rule #1: closed
intersection lines. In order to be able to trim a surface, the intersection line that
divides the surface that you wish to trim up into separate regions has to be
closed.

Intersection line

The intersection line does not go all the way up to the deck edge. The hull surface can therefore not
be trimmed to this transverse surface....

L

T

... whereas now the intersection line divides the hull up into two separate regions:

Trimming — Concepts — Trimming Sequence

Trimming Sequence
The following diagram is also useful to see again in this training manual:
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Start State

A 4
[ Step 1: Turn trimming on

1 a. Trimming Gray
1 b. Trimming Invisible

Step 2: Start Trimming & Select
Step 5. Repeat Maxsurf in Trim mode > Su_rfaqe
Trim other surfaces (optional) 7l 2a S_urface_s | Start Tnmm_lng_| <Su_rface>
2 b. Right click on surface in view window
2 c. Right click on surface in Assembly window
A
\ 4
. Surface regions
Surface Trimmed . . ace reg
Cancel trimming highlighted
From right click menu
A
\ 4
Step 4: Trim Surface (
4a Cul+ T ) Surface Regions Step 3: Select Regions to trim
4 b. Right click anywhere in screen and i Selected Regions in grey will remain visible
select Trim <Surface> €lecte 9 grey
4 c. Surfaces | Trimming | Trim <Surface>

It is important to note that after doing step 2, you have to do steps 3
and Step 4 as well. Maxsurf will continue to ask you to select your
regions and trim the surface until you finished Step 4.

Continue with the first application for trimming: Trimming a transom.

Trimming a transom

Trimming a transom — Concepts

A transom can be added to a design in two ways.
e Bond the transom to the hull

e |ntersect the transom with the hull and trim the surfaces

The recommended method is dependent on the shape of the transom and the
transom-hull transition. For example:

The transom is blended into the
hull with a fillet radius. In this
case it is impossible to use
trimming and you should use
bonded surfaces.

Radius

The transom on this ship almost
literally cuts off the hull. In these
cases trimming is recommended.
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Trimming a transom — Video

In some of the sample designs
supplied with the program, you
will see examples of ships that
have no transom at all. A model
does not “need” a transom when:
- the model is used for hydrostatic
calculations

- transom shape is planar

- transom orientation is vertical
and orthogonal to the centreline.

In general it is good practice to
close the model completely
(adding a transom and a deck to
make it a “closed box™).

# View a video that shows you the use of trimming after inserting a transom
surface. This video also shows how the trimmed surfaces automatically update to
changes in surface shape or position. [Web | Disk]

Trimming a transom — Procedures

In this section you will insert a 2™ surface in your MyFirstDesign model and use
that as a trimming surface to trim the hull to a transom.

.,

> Open MyFirstDesign.msd and Save it as
MyFirstDesign_TrimmingTransom.msd

> Lock the Hull surface

> In Profile view window, Insert a Section plane surface from

Surfaces | Add Surface:

a—

!

> Change the name of the Transverse surface to “Transom”

» Show the Net, Hide all Contours except edges, and Display |
Contours | Intersections or use the ~* toolbar button

» Drag the control points to as displayed in the image below:

!

=
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You may have noticed that there are two corner control points directly behind
each other in Profile view and thus they appear to be only one control point. Use
the selection box to make sure you select both:

>

You can see the intersection line (red in the image above) dividing the hull into
two separate regions. This means you are now ready to trim the hull. If you refer
back to the Trimming — Concepts — Trimming Sequence

Trimming Sequence on page 117 you’ll see the steps we have to take:

» Step 1: Switch trimming on: Display | Trimming | Trim Invisible

» Step 2: Select the Surface to trim. There are several ways to do
this, but the fastest way is probably by right clicking on the
intersection line and select Start trimming Hull:

Skart brimming Hull
Skark trimming Transverse Plane

Unkrim...

il

This will highlight the currently visible (read: “untrimmed”) regions of the
selected surface. There are 2 regions separated by the Intersection line.

> Step 3: Select trimming region: Click inside area 1. This will hide
this area (read: “this will trim away this area”).

> Step 4: Trim the Surface: There are also many different ways to
do this step, but probably fastest is to either hit “Ctrl+T” on your
keyboard or right click anywhere in the screen and select “Trim
(Ctrl+T)”.

[i .
I
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» Switch to Rendered Perspective view to check your work:

The transom is not making the model look very nice at the moment. You can
trim away the surface completely:

» This time Right click on the Transom surface in the Assembly tree
and select “Start Trimming”:

% X Pearspective EEE
=3 Design
4a Hul e
Jrﬁﬁ Add Assembly E
Delete e
Rename ‘ B
Hide: “_é
v Show o
Lock L
w Unlack, i
e 3
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Properties T T T T T T T T T T T —T T
. o0 0w B 180

» Go through steps 2, 3 and 4 to completely trim the Transom away.

Note: You may have noticed that you could not select different regions on the
transom. This is because the intersection line does not form an enclosed region.
Trimming the Transom only “hides” the trimmed region of the Transom. The
surface is still there and the trimming can be undone at any point.

Now let’s make the shape of the transom a little bit more interesting:

> In Body Plan view select this control point:

\

N

oo

o~

And then insert a Row of control points here:

L=;T:T;
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The reason for first selecting the control point in the Right Top corner is that
otherwise you may get unexpected results when inserting this row such as:

\\%LT

» Switch to Profile view and drag the control points backwards:

» Check again in Perspective view:

>

Notice that the shape of the trimmed hull has automatically been updated to the

new shape of the Transom. As long as the intersection line between the surfaces
remains intact (read: closing off the trimming regions) you can make changes to
both the hull and the transom and the trimming will automatically update.

» Try moving the Transom Fwd and Aft and check that the
trimming is updated continuously. The best way to do this is
probably in Profile view with Buttocks displayed.

T & 2T

a —

4 === —

% The advantage of using trimming is that you can fair the hull surface and
model the shape of the transom completely independently. This gives you a great
freedom of what shape you wish to make the transom. It does mean that you
have to extend the hull aft of the transom. For example if you wish to model a 40
m yacht, you will have to model a hull of 41 m long and insert a transom surface
1 m fwd of the Aft Extremity of the hull.

Congratulations! You have performed your first trimming operation. In the next
sections we will practice this some more by also inserting a deck surface and a
bowthruster.

Continue with the next section Trimming a Deck and a Bowthruster.
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Trimming a Deck and a Bowthruster

Trimming a deck — Concepts

Decks are very similar to transoms in that a deck also closes the hull. Usually in
Maxsurf you do not want to model a fillet radius between a deck and the hull
(that is unnecessary detail for hydrostatic calculations) and therefore a deck is
added to a model using trimming in most cases.

One of the advantages of using trimming when adding a deck is that the deck can
be shaped completely independently from the hull and have completely different
properties (i.e. stiffness). If you were to use bonding the deck and the hull would
have to share the same degree of stiffness in the longitudinal direction (you will
learn this later). Some examples of a deck that has been added using trimming:

The deck of this bulker has several step ups at the poop deck and F’castle. Several hatch coamings,
cranes and a superstructure have also been added and are also trimmed to the deck.

camber

The deck of this sailing yacht has camber in transfers direction and has a cockpit opening trimmed
out as well as a coachroof on top of it. All this is very easy to do with trimming.

In the previous section you learnt how to use trimming to trim the hull to a
transom. In this section we will practice what you have learnt and insert a deck
surface as well as bowthruster.

T ———

Trimming a bowthruster — Concepts

A bowthruster is a cylindrical opening in the hull. A bowthruster can be
modelled for different reasons:
1. Realistic rendering or image of the design. Use highest precision to get
best rendering results.
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2. The production geometry. In particular the intersection line of the
cylindrical bowthruster surface and the hull.

3. Hydrostatic volume of the hull. The volume of the bowthruster is not
part of the buoyant volume of the hull. Hydrostatic calculation software,
such as Hydromax, use transverse sections to calculate the volume of the
hull. The volume of the bowthruster is calculated using the same
transverse sections as for the hull. Since the hull is generally much
bigger than the bowthruster and the spacing of the transverse sections is
dependent on the length of the hull, the bowthruster volume can not
always be calculated accurately because there are only a few sections
intersecting the bow thruster.

200 transverse sections along the length of this Containership.
Only a few intersect the bowthruster.

L F

1=}
-
[1:]

=
7]
=
-3

b 20 40 B0 a0 100 120
Station Position m

The curve of areas only uses up to 36 transverse sections. The volume of the bowthruster can not
be seen in the curve because none of those sections intersect the bowthruster.
When an accurate hydrostatic volume is required, it is recommended to
model the bowthruster as a non-buoyant volume compartment in
Hydromax rather than using trimming to create an opening in the hull.

In this section of the training document we will insert a cylindrical shape that
consists of two half-cylinders. Then we will trim that to the hull and visa versa in
order to get a produce a rendering of the hull.

Trimming a deck and bowthruster — Video

#= View a video that shows you how to quickly model a step in a deck surface,
insert a bowthruster and use right click trimming. [Web | Disk]

Trimming a Deck — Procedures

> Use the model from the previous section or open
MyFirstDesign_TrimmingTransom.msd

» Save the model as MyFirstDesign_TrimmingComplete.msd
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» In Profile view, lock all surfaces, display Buttocks and switch
trimming on (Display | Trimming | Trim Invisible).

You should see something like this:

£ Profile EIE)E
S 7
« 23515 5 15429 Ty 3340 2

Start with adding a deck surface:
» Surfaces | Add Surface | Waterplane

> Using the Assembly Pane (View | Assembly) rename the
Waterplane - Deck

+%%;/

> Use a Selection box and drag the control points down

> After dragging them down (1), Move the aft edge of the Deck well
Aft of the transom (2) and extend the fwd edge of the Deck beyond

the bow (3)

i :
‘f'-' I---I
n ﬂ;’; %
» Insert two rows of control points

S (E | B

- S
I_—-——E—%{/j

+

» Model the Deck surface so that it looks like this. Keep using the
Selection box every time you move the control points, else it will
become a mess quickly!

]|

+
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» Display intersections
» Switch to Plan view:

EEE

A 5 0

++ 3565 $-2132 ¥™y 356.6" e

» Drag the outer edge of the Deck surface well beyond the
maximum beam of the hull. Tip: Use a selection box and hold the
shift key down while dragging outwards so that the control points do
not move fwd or aft unintended.

Deck surface extended well beyond Hull surface to form a closed intersection.

You are now ready to trim the Deck surface to Hull and Transom, the Hull to the
Deck and Transom, and the Transom to the Deck and Hull.

> Use Plan view to trim the Deck
> Use Body Plan view to trim the transom
> Use Profile view to trim the hull

» Use Perspective view to check your work:

The black lines along the edges of the Transom and Deck become visible when the surfaces are
unlocked.

» Save your design

Trimming a Bowthruster — Procedures

We are going to insert a cylindrical bowthruster with a 1m radius (not very
realistic, but makes it more visible) and then trim the hull to the bowthruster and
visa versa. Rather than creating a cylindrical surface ourselves, we’ll use the
inbuilt shapes generator in Maxsurf:
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Add|Shape - Cylinder 3

Orientation;
el * Laongitudinal
F2
-{:e- ™ Transverse

" Wertical

Length:
: |5 m

12: |5 m

Options;

[ Close Ends

v Symmetrical
f* Half Model on Centreline
" Full Model

Ok | Cancel

This dialog automatically generates a cylindrical shape of any size in any orientation.

» Lock all surfaces, Hide intersections
> Surfaces | Add Shape | Cylinder
This brings up the dialog above.

> Set the Orientation to Transverse, specify a 6 m length, a 1m
radius and tick the Symmetrical half model on Centreline model
option. You do not need to close the ends of the bowthruster.

> Click OK

FiH Profile

++ 3417 % 666 €7y 5.6 Pl

> Inthe Assembly Pane, rename the assembly called “Transverse
Cylinder” > “Bowthruster”.

> Open the Bowthruster assembly folder and notice that there are 2
surfaces in there:

sl B othiuster
% i CylinderBattom
i CylinderTop

» Making sure you have the Net displayed and using a selection box,
drag all control points to the bowthruster position (use your own
creativity, but preferably below the waterline).

> E/f

We’ll now use perspective view to trim both surfaces to each other:
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» Switch to Perspective view, rendering off, hide buttocks, display
intersections

» Lock the Bowthruster assembly using a right click command:

=3 Design r;'
;] Bovthrusied

4@ Hull Add Assembly
4@ Tranzom
@ Deck Delste
Rename
Hide
Show
Ubniick.

The Assembly tree allows you to lock groups of surfaces.

» In Perspective window, zoom in to the bow and rotate your model
so that you can clearly see the intersection line and the bowthruster
surface edges:

£ Perspective EEE
-12q 10

S

LML L B L ) N N ) PO L B I B Y O S N L B |
-0 0¥aw 20 | 1
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g

» Now select the Hull-Bowthruster intersection line with your left
mouse button and then use right click trimming on the Intersection

line:
! E‘
Start trimming Hull

Start trinming Cylinder

Unkrirm. ..

B~ = Z-

1

Right clicking on the intersection line is a quick way to trim both surfaces

» Trim the Hull, the Cylinder Top and the Cylinder bottom surface

Trimming the hull by clicking inside the Intersection region with the bowthruster

When you are done trimming, your model should finally look like this in
Rendered Perspective view:
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You may notice some rectangular rendering around the cylindrical opening. This is purely a

rendering/drawing artefact and nothing to worry about; it will not influence any calculations.

» Switch to highest precision to improve the quality of the
rendering.

> Save your design as MyFirstDesign_TrimmingComplete.msd
Finished!

Continue with the section on \When Not to Use Trimming.

When Not to Use Trimming

Try to avoid using trimming for a transom that has to blend in with the hull:

! ! Smooth transition between transom

and hull topsides intended

What happens when you do try to this is that you get a “shallow intersection”
between the hull and transom surface which usually means that the intersection
line changes shape rapidly or is even broken when a small change to any of the
surfaces is made. It may also cause problems when you switch to a higher
precision and the intersection line is calculated differently:

! At Lowest precision

No trimming region at lowest precision
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At Medium precision
Trimming region at medium precision

Use bonding for these cases instead.

The only case where you cannot avoid using a shallow intersection trimming
surface is when you want to model a propeller tunnel:

You need the shallow intersection for minimum disturbance of the water flow towards the propellers.

This is very difficult to model properly because it is difficult to get the shape of
intersection line right and often the trimming fails when switching between
different precisions. How to do this is not covered in the LearningMaxsurf
training manual.

You have learnt all the basics about trimming and can now continue to the
section on Chapter 9 Bonded Surfaces.
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Chapter 9 Bonded Surfaces

% Maxsurf allows you to bonding two surfaces together. Surface bonding can
be seen as gluing two identical edges together.

In order to get two identical edges, both edges need to have:
e The same number of control points

e The same degree of stiffness
If either of the above is different, then both edges can by definition not have the
same shape which would result in gaps between the surfaces.

Two edges with matching control points, but different stiffness. This causes gaps to appear between
the surfaces.

Maxsurf checks that both edges have the same stiffness and number of control

points prior to bonding and will notify you if the edges cannot be bonded
together:

@ The edges you have chosen do not share the same deqgree of stiffness.

Modify the surface stiffnes walues so that the chosen edges have the same walue.

After you have bonded two surfaces, Maxsurf will make sure that the surfaces
that share the bonded edge are treated more or less as one and apply any changes
to one surface to the other bonded surface as well. For example when adding a
control point to the edge:
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Bonding (x)

This change affects other sufaces that are bonded to
thiz surface.

Do you wizh to extend the change ta the other surfaces?

Cancel

In this section you will bond several surfaces together and learn about the
different bonding types you can apply. You will also learn that the duplicate
surfaces command is a quick way to ensure that both surface edges share the
same properties.

Continue with the section Designing a Simple Multi-Chine Hull using Bonding.

Designing a Simple Multi-Chine Hull using Bonding

Multi-Chine design — Concepts

A multi-chine hull may consist of for example topsides, spray rail and a bottom
panel. The properties of these panels can be very different. For example: where
the spray rail can be a linear panel (zero curvature transversely), the topsides and
bottom may have some curvature. Especially when the design is built out of
aluminium or steel and all panels will have to be expanded into flat plate stock
for cut production geometry, it is therefore often a good idea to use separate
surfaces for each panel. Bonding is used to weld or glue the panel (read: surface)
edges together.

Multi-Chine design — Video

&= Watch a video shows the procedure of bonding two surface edges and shows
what happens when you try to bond two edges without matching stiffness. This
video also shows how to use the Duplicate Surfaces command to ensure that both
surface edges share the same properties. [Web | Disk]

Multi-Chine design — Procedures - Start

Start

In this section we will again start a design from scratch. If you have an existing
design open, you will have to close it first.

> Select File | New Design.

We will start by inserting a flat, longitudinal plane which will become the
Topsides surface:

» Surfaces | Add Surface | Buttock plane
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» Resize the surface to have a length of 40 m and a depth of 3 m.

Size Surfaces &

Select Surfaces ta resize:

Select Al | Dese|ecm|||

J Langitudinal Plane Proportional
Scaling

r i‘ Length
I—. ’Drni i‘ Beam
I; la'mi i‘ Depth
[~ re-scale markers

Ok

ok |
Cancel

» Save the design as Bonding_Start.msd.
The surface should look like this in the perspective window:

E|Perspective EE&E
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> In the Profile window add 3 control point columns. Try to
distribute the columns as in the image below:

E7 Profile FEE&®
. o — I
o o o o ;!
++ 3352 3+ -7.a04 Ty 29410 e 8223

Control point distribution with increasing density towards the right
(which will become the bow).

> In the Surface Properties dialog, name the surface “Topsides” and
set the longitudinal flexibility to 4.

Remember that there are several ways to get to the Surface Properties:
e Surfaces | Surface Properties ...
e Double click on the surface in the Assembly Pane
e Using the right click menu from the Assembly Pane

e The Properties Pane

> Save your design

» Move the surface 5m to starboard and 5 m up.
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You can do this for example by using the Surfaces | Move Surfaces | Numerical
menu option, or setting all control points on the surface offset position to 5 m.

Move Surface =]

Select Surfaces to Move:

Select All | DeselectAII|

J  Topsides

Spacing:
Longitudinal:

Transverse:

Om

Sm

WVertical: 5m
ak.

Cancel

Moving the selected surface 5 m transversely to starboard and 5 m up.

» Close the bow by moving the fwd-most column of control points
transversely to the centreline. Do not change their longitudinal
position.

One way of doing this is by selecting both control points in the fwd-most column
and then setting the Controls | Control Properties to 0 m offset. Another way
would be to use a selection box in Plan view to select both control points on the
fwd-most column and then drag them to the centreline while holding the shift
key down. Tip: when a surface is symmetrical, you can drag control points past
the centreline (to the portside of the centreline) to snap them to the centreline.

You should now see something like this in Plan view:
BB

w461 3 11624 ¥y 291.6° "

» We do not need to see the Grid, so Display | Hide Grid
> Save your design.

Let’s leave the Topsides surface for what it is now and move on to inserting a
chine surface.

Multi-Chine design — Procedures — Insert Chine

Inserting the Chine
» Lock the Topsides surface
Repeating almost all of the steps above:
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> Insert another Buttock plane, resize it to 40 m length by 3 m
depth, insert 3 columns of control points in roughly the same
longitudinal positions, change the colour and rename this surface to

Chine.

Ml Perspective EE®
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» Unlock the Topsides and save your design as Bonding_Chine.msd

You are now ready to bond to bond the lower edge of the Topsides with the
upper edge of the Chine.

»  Switch to Perspective window

> Make sure you have Display | Contours | Bonded edges switched
on

» Read the section on Bonding Surfaces in the Maxsurf user manual
up to the “Bonding with Tangent Continuity” section.

In this tutorial we will use the edge selection method to bond the edges. We
could have chosen to use the edge control points with exactly the same outcome.

> Select the Lower Topsides edge (1)
» Holding the shift key down, select the Upper Chine edge (2)

> Now select Controls | Bonding | Non-Tangency (3)
[ Cortrols | Sufaces Display Dats Window Help
R.ioc. iR0E 880 A
2uB. SwebFloel .

Srmankh Contrals 3

Straighten Conkrols y

Rotate Contrals. .. = clive |'_”E|E|

R align To Veckar 180
IF2 Align To Plane L
+ Compack Chrl+K 1 :JII
/ Group Chrl+iz 2 :—:
7 Unaroup Chel4U fu
x Unbond Edge Appsoximate Tangency EBU
T Mask Strict;l'angency ;—
1T Unmask 3 [
T AR LT —TT
Sran Ta rid = i =1 i1

You will see the following error message:
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@ The edges you have chosen do not share the same degree of stiffness,

Modify the surface stiffnes values so that the chosen edges have the same value,

This is because we have “forgotten” to set the Chine’s longitudinal stiffness to 4
(the same as the Topsides).

> Set the longitudinal stiffness of the Chine to 4 and repeat the 3
bonding steps above.

You should now see something like this:

Il Perspective

Topsides Botkom/Chine Top (CO) Yikrail

Notice how the Chine Top edge was moved towards the Topsides Bottom edge.
This is because we selected the Topsides Lower edge first. Also notice how the
names of the two bonded edges are displayed in the lower left hand corner of the
Maxsurf application window. This means that Topsides Bottom and Chine Top
edges have been bonded with a non-tangent (CO0) transition.

> Switch to Plan view

> Select the aft 4 control points on the centreline row of the Chine
surface with a selection box.

» Holding the shift key down, drag the selected control points
outwards until the roughly the required chine shape is obtained
(something similar to that shown below).

I —
_______________________________________________________________________ |

Plan view
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> Switch to Profile view

» Set the Height in Control Properties of the lower edge of the Chine
to 3.5 m and Move the Fwd Top corner control point of the Topsides
surface to shape the bow:

Ed Profile EEx

++ -21.802 § 0783 ¥y 172.5" W 4531

You should now see something like this in rendered Perspective view with
Display | Half off.

I Perspective BHE&®
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» Save the design
You are now ready to insert the bottom surface.

Multi-Chine design — Procedures — Inset Bottom

Inserting the Bottom

The final surface we want to create is the Bottom surface. Instead of creating this
surface from scratch and set it up so that its edges match that of the Chine and
the Topsides, it is much faster to duplicate for example the Chine surface or the
Topsides surface and use that. This then automatically gives us a surface edge
with identical stiffness and number of control points.

» Surfaces | Duplicate

» Try to select just the Topsides surface. Notice how the Chine is
also selected. This is because they are bonded.

» Untick the Respect Bonding and deselect the Chine

» Space the duplicate surface 5 m below the Topsides:
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Duplicate Surface

Select Surfaces to Duplicate:

Deselect &l | Select Al
J  Topsides Duplicate |1 Times
Chine
Spacing:
Longitudinal,  [0m
Transverse:  |0m
Wertical -Hm

@espect Bonding
o]
Cancel

» Rename the duplicate surface Hull Bottom. In the perspective
view you should end up with something similar to the following:

Il Perspective
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> Rename the Copy of Topsides surface to “Bottom”
» Save the design as Bonding_Bottom.msd

> Switch rendering off and Display | Half

> Select the Bottom edge of the Chine (1)

> Select the Top edge of the Bottom (2)

» Bond the two together using non tangent transition (3)

I Perspective EE)E
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Make sure you don’t accidentally select any of the Topsides edges. You can do
that by hiding the Topsides surface or switching bonded edges off temporarily.

> Switch to Profile view
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> Set all the Bottom surface’s Bottom edge control points’ offsets to
0.

> Model the Bottom surface’s Bottom edge so that it looks like this:

E4 Profile

++ 5018 1 -46N ¥"y 355.3° W 4021

In rendered Perspective view with Half display off you should see something
like this:

» Save your design as Bonding_Bottom.msd

Done! This is basically a very simple starting point for any hullform with a spray
rail or chine. Continue with the next section where you will be making
Refinements to the Multi-Chine Hull Model. This revisits a lot of steps from the
tutorial where you modelled your first design as well as fairing tips.

Refinements to the Multi-Chine Hull Model

FOR, Zero Point and Grid

First, let’s set the Frame of Reference (FOR), zero point and insert a Grid:

> Set the DWL to 3.5 m above the Baseline and set the Aft and Fwd
perpendiculars in the Frame of Reference Dialog.

> Set the zero point to Aft Extremity and Baseline.

Also make sure the Locked Zero Point check box is unchecked so that the zero
point will change with the aft perpendicular if it is moved. In case you don’t
quite remember the steps to doing this, please see Design Preparation —
Procedures on page 54 of this training manual.
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» Insert a Grid of 12 sections, 5 waterlines and 4 buttocks all evenly
spaced along the length, depth and width of the model respectively.

» Save your design as Bonding_Refinements.msd

Modelling in Profile view

Next step is to shape the forefoot in the Profile window. First we must set the
flexibility of the Topsides and Hull Bottom surfaces to 3, to do this there must be
at least 3 rows of control points in each surface:

» Switch to Body Plan view and Hide the Net, Display | Half, turn
Sections off.

> Use the control box to select the Aft-most column of control
points:

» Add a middle row to the Bottom and the Topsides surfaces:

£ Body Plan

E+i|Body Plan
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> Now set the transverse flexibility values to 3 of the Topsides and
Bottom.

Notice that in the Transverse direction, the stiffness of the Chine and the
Topsides and Bottom do not have to match. This is because the surfaces are not
bonded along an edge in the Transverse direction.

> Switch back to the Profile view.

» Shape the forefoot by moving the Control points to positions that
give the required shape.

Tip: In order to get a smooth transition across the Lower Fwd Bottom corner
control point, you have to make sure that the two adjacent edge control points
and the corner control point are all on one line. Also: when shaping in the Profile

and Plan views it is usually helpful to compress the view ’E :
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» Continue shaping the bow and as well as the Chine Profile so that
it looks like this in compressed Profile view:

F Profile BEE

EERE: 2723 357.4° 40.814

» Check your work in Perspective view:

I Perspective EE&®
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> Save your design as Bonding_Refinements.msd

Modelling in Body Plan view

Currently the Topsides are wall sided. Best way to change that is in Body Plan
view:

» Switch to Body Plan view, Hide the Net and turn Sections off

> Starting from aft, use the Control Box to move the control points
in each column and give the Topsides an outward slope:
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Ed Body Plan FE&E
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Giving the Topsides some outward slope in Body Plan.
» Save your design

Modelling in Plan view

» Switch to Plan view, hide the waterlines and display the Net

» Clean up any Zigzags and turn them into Bananas, especially in
the bow area:

BB
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Zigzags in Plan view with Compressed view turned on

EE)E
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Better: bananas towards the bow

Remember that, even though the shape of the design may not change that much,
improvements to the control point net will improve the fairness of the underlying
surface. See Fair Net Equals Fair Surface on page 103 of this training manual for
some reminder information.

» Check your work in Perspective view and the other 2D view
windows.
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Remember that modelling is an iterative process and you may therefore want to
make several runs through the Profile - Body Plan - Plan - Perspective
views etc.

Finally we will see one of the nice things about bonding:

> Insert a column of control points in Plan view in the Topsides
surface in the bow area:

Thiz change affects other surfaces that are bonded to
this surface.

Do vou wish to extend the change to the other surfaces?

Cancel

Inserting a control point column across bonded surface edge will affect all bonded surfaces

> Click OK

Notice that the control point column has been inserted in the Chine and Bottom
surface as well. Another change that will be applied to all surfaces is a change to
Surface stiffness.

» Check the stiffness settings for the Bottom surface
» Increase the longitudinal stiffness to 5 for the Topsides surface

Notice that the longitudinal stiffness for the Bottom surface has automatically
been increased to 5 as well.

» Save your design as Bonding_finish.msd
Congratulations! You have finished the Bonding tutorial. You should have learnt
from this:

e In order to be able to bond two edges they must share the same number of
control points and degree of stiffness.

e When bonding, the 2 edge you select moves on top of the 1% edge you
select.

e Duplicating a surface is a quick way to ensure that both surface edges to
be bonded share the same properties.

e After bonding, all bonded surfaces are treated more or less as one surface.
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Chapter 10 Calculations

% Maxsurf allows you to quickly assess the model’s upright hydrostatic
properties. In order to be able to calculate the hydrostatics, you need to make
sure:

e Frame of Reference and the Zero Point have been defined

e Trimming is turned to Invisible or Grey in case you have used trimming

Surface trimming affects the hydrostatic results.

Start learning about calculations in Maxsurf in the section on Calculating
Hydrostatics.

Calculating Hydrostatics

Calculating Hydrostatics — Concepts

Maxsurf’s Upright hydrostatic calculations use trapezium integration method on
a given number of transverse sections up to the Datum Waterline. The number of
sections depends on the precision setting from the Surfaces menu. Medium
precision uses 50 sections and highest precision uses 200 sections. Skin
thickness is not included in upright hydrostatic calculations. (Use Hydromax for
this).

The sections used for calculations are displayed in the view windows while the
Calculate Hydrostatics dialog is displayed.

Calculating Hydrostatics — Video

#= View a video that shows you how to carry out Upright Hydrostatic
calculations, view the Curve of Areas and calculate different Surface Areas.
[Web | Disk]

Calculating Hydrostatics — Procedures

» Open the MyFirstDesign_TrimmingComplete.msd design that
created earlier.

In Profile view you should see something like the image below (Trimming off,
Surfaces Locked, Buttocks hidden):
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E+ Profile

- - ey [

> Check the Frame of Reference:

Frame of Reference and Zero point

[~ Longitudinal Datum - 1 ~Vertical Datum -
° Aft Perp. ] SettoDWLI " DWL |3m
" Midships (21 m " Baseline |Um Find Basel

" Fwd Perp. ]42 m Setto DWL| " Other IS m
Aft extent
@ Other ]Um Malill

Fwd extent

I oK I Cancel

In the Frame of Reference of this design the Fwd Perpendicular is not set correctly.
Click “Set to DWL” to fix.

» Go Data | Calculate Hydrostatics
The following dialog should appear:
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Hydrostatics at DWL 3]

Measurement
izplacement

Density  |1.025 tanme/m™3 Recalculate
VoG [Om Close |

> Click in the Top left corner of the results dialog to select all cells
> Press Ctrl + Shft + C
> Start MS Excel and Paste the results into a worksheet

Let’s now compare these results with when we switch trimming on.

» Set Display | Trimming | Trim Invisible

EH Profile

- ;- Ty e

Zero point locked at Aft Extremity

> Check the Frame of Reference again
» Adjust the Fwd and Aft Perpendicular and Set to DWL.

Notice that the zero point is locked at the Aft Extremity of when this model was
first created. It is now time to adjust the zero point to the Aft Perpendicular.

> Set the zero point to the Aft Perpendicular

> Data | Calculate Hydrostatics
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Copy and paste the results into Excel worksheet next to your

previous results.

Displacement
“olume

-~ A

o

1

-

A [ B | ¢ [ D | E | F | 6 |
Trimming Off trimming On
Measurement Value Units Value Units

Measurement

E90.51 e Drieplacerment—® E553.05 tonne
B73.669 m"3 “olume 637.12 m"3

- A M

With trimming on the displacement is less than when calculating with trimming off.

After calculating the Hydrostatics, you can also display the Curve of Areas
graph:

N

r

Window | Curve of Areas

FH Curve of Areas

.....

45

15 20 25 30 35 40

Station Posttion m
Station Position = 7.297 m

10

Area = 20082 m*2

The vertical line may be moved with the mouse to read off the sectional area at
any longitudinal position. By doing this for a number of different drafts a set of
Bonjean curve data may be collated. The curve of areas uses 25 sections along
the length of the hull by default. You can change this number from the Edit |
Preferences menu.

Continue with the section on Calculate Areas.

Calculate Areas

Calculate Areas - Concepts

Maxsurf can also quickly calculate the Surface areas for you. This information
may be useful when you are trying to estimate a steel weight for a surface (3D
surface area) or the windage area of the model above the waterline (2D projected
lateral area). All this data is available in one dialog.

Calculate Areas - Procedures

N
r

Read the Calculate Areas section of the Maxsurf manual.

> Calculate the 3D true surface area for your
MyFirstDesign_TrimmingComplete.msd

N
r

Do this with trimming on / off to see the difference

In case you wish to calculate the total 3D true surface area for all surfaces except
for, for example the Transom, you can hide that particular surface.

> Hide the Transom and Calculate the Areas

You’ll see that the transom is now not included in the Surface area list.

The last short section in this training manual is on Chapter 11 .
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Chapter 11 Creating a Maxsurf Model from
Existing Data

This section explains and provides examples on how to get different types of
data into Maxsurf and how to create a Maxsurf model from the data.

There are a number of tools available for bringing existing data into Maxsurf and
creating a Maxsurf model. The best method to use depends on the existing lines
plan data type and what you want to do with the Maxsurf model.

Lines Plan Data Type & Import Options

> Read the Input of Data section in the Maxsurf manual.

Maxsurf can import a range of data formats to assist you in creating a Maxsurf
design to match existing data. Essentially the options are:

e Importing a Background image into Maxsurf

e Importing Data as Markers

Importing a Background image

Maxsurf has the ability to display background images in each of the design
views. Maxsurf can load image files of the type jpg, gif, bmp and png.

If the Line plan is a paper version then you can scan it and import
the scanned image into Maxsurf.

For more information including tips on how best to scan a paper lines plan, see
the Importing background images section of the user manual. The Importing
Background Image 7 Scaling an existing Design tutorial below explains the
process of importing a background image

Importing data as Markers

> Read the Working with Markers section in the Maxsurf manual.

Markers are reference marks displayed on the screen at a specified longitudinal,
transverse and vertical position in space.

\XX%gv
¥ X ¥ B
LY

¥ xEEY
XXXX
X % 8%
Xxxxg
s S e B R

Example of Markers defining the starboard side of a round-bilge vessel with bulbous bow.

Once the markers are in Maxsurf there are a number of tools available to create
the 3d Maxsurf model using the marker data.

Creating Markers in Maxsurf

Marker data may come from a variety of sources such as:
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Offsets table data

Offsets tables can be manually input or copied and pasted into the Maxsurf
marker window (switch to the Marker window in Maxsurf and select markers |
Add Marker).

3D DXF

If the existing lines plan is in 3D DXF format, it can be read directly into
Maxsurf and markers generated automatically. To do this, start a new design,
select File | Import | Import DXF markers, select the file and then specify the
orientation of the design in the DXF file. Note that when importing the DXF file
all nodes of all lines and poly-lines are converted to markers. It is normally
easier to delete all unnecessary lines in the DXF file rather than trying to delete
the unwanted markers in Maxsurf. All that is required in Maxsurf are the
markers that define the hull shape.

2D DXF

If you have a 2D DXF lines plan, it is normally quite easy to generate a fairly
comprehensive 3D DXF model. This is done in a standard CAD package such as
AutoCAD. Start by extracting the body plan and noting the longitudinal
positions of each of the sections that are defined in the body plan. Select each
section in turn and move it longitudinally so that it is in its correct location.

Copy 2D Body Plan & create 3D model
Select each section in turn and move it longitudinally so
that it is in its correct location (eg section spacing = 1m)

Note longitudinal section spacing
(eg spacing =1m)

3D digital .dxf Iin plan created from a 2D lines plan

Maxsurf Model Requirements

If the Maxsurf model is required for production purposes then the Maxsurf
model will need to be created from a faired NURB surface. Chapter 4 NURB
Surfaces. However, if the Maxsurf model is required for the purposes of analysis,
for example Hydrostatic analysis in Hydromax, then the Maxsurf model can be
simply generated as a TriMesh surface. See_Importing dxf Marker Data &
Generating a TriMesh model Tutorial.

150



Creating a Maxsurf Model from Existing Data Tutorials

The following tutorials provide example of creating Maxsurf models from

exiting Data:

Importing Background Image Tutorial

Importing dxf Marker Data & Generating a TriMesh model

Importing Marker Data & NURB Surface Models

Importing a Background Image & Scaling an Existing Design Tutorial

Maxsurf allows you to import one background image in each view window. This
means that a typical lines plan image (example below) will need to be split up
into 3 separate images; one each for Body Plan, Profile and Plan view.

Importing a Background Image & Scaling an Existing Design — Procedures

™~

DWL: 0.2m
BREADTH (MAX):  20.0m
DEPTH (MAX): 15.0M
DRAUGHT: 7.0m

€T 120m CONTAINER SHIP

™ LINES PLAN

T
FORMATION DESIGN SYSTEMS

=
l 1:150 I A

Typical lines plan image of a Container Ship.

» In Maxsurf, open the ContainerShip.msd sample model.

> Display only edges and lock the surface for now. Hide the grid.

This design is similar to the design in the lines plan image and we will use it as a
starting point. It is always a good idea to open a design first before importing
images. This helps when try to make the zero points of the model correspond to
that of the lines plan model.

The zero point of the lines plan is at the Aft extents and the Baseline. Therefore
set up the Containers ship Maxsurf model with the zero point at the Aft extents

and the Baseline.

> Switch to Profile view window

» Go to Data | Frame of Reference
> Set the Zero Point to Aft extents & Baseline
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Frame of Reference and Zero point [Z|

- Longitudinal Datum————————— ~Vertical Datum -
" AftPerp. |[0m Setto DwL " DwL B6m
" Midships |50m If" Baseline |0m Find Base ”

" Fwd Perp. {100 m Set to D'WL " Other |2.El43 m
@ Other -4.159 m

Fwid extent

oK Cancel

% |

Set the Frame of Reference of the Maxsurf model to correspond to the Lines Plan.

Now import the background image.
»  Switch to Profile view window

> Now go File | Import | Image Background and select the
Containership Image - Profile.jpg file.

You will now see something like this:

Profile

+» 90.358 $ 1208 ¥y 0.8° W« 90.366

The zero point of the image and the scale still needs to be adjusted.

You can now set the zero point of the image:

» From the Display menu, select Set Image Zero Point -

Background ¥ | Hide owF
Grid 3 Show DeF
Contours. . Dilete DXF
Render...

gender Hide Image
Bnirnate, .,

|Z| Shaow Image

Delete Image
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» Zoom in on the Zero pint of the Lines Plan image:

Profile

s+‘| st? st3 std 516 st6 st7 =10 5td stl0stilsti2stiBst14 st 16 =1
e pt

+» -2.832 $ 34.027 Wy 94.8° W 34.145

Setting the zero point of the background image

> Set the zero point with the tip of the mouse cursor by clicking on
the Zero point of the lines plan image.

» Zoom out by pressing the Home view button. fa}
The zero point of the image has been matched with the zero point of the model

_ Profile

| +» 73512 $ 8633 Y 6.7° W 74017

Zero point of background image set

Next step is to scale the image to the Maxsurf coordinate system. l.e. when the
ship is 120m long in real world, we can scale the image so that it is 120m in
Maxsurf space. In Maxsurf you can do this by specifying a reference point. This
point can be for example the Fwd extremity, the deck height or any other point
of which the horizontal or vertical distance to the zero point is known.

In this case, we know from the lines plan that the LOA (length Overall) is 120m.
We can scale the image by telling Maxsurf where the Maximum length of the
lines plan image is.

» Zoom in on the position of the maximum length location —
approximately half way up the bulbous bow.
> Display | Background | Set Image Reference Point &

> Set the Reference point with the tip of the mouse cursor by
clicking on the maximum length location — approximately half way
up the bulbous bow:
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| Profile

Maximum length location
- approximately half way
up the bulbous bow

36 =thb st6T =thd sthY =thll

+» 187.864  § 3505 ¥y 1.1° W« 187.897

Set reference point

This brings up the Background Image Reference Point dialog:

Background Image Reference Point @

Clicked point is | 120] from the zero point.

i~ Direction:

" Longitudinal
| vertical [

OK I Cancel I

Input reference point length
» Specify 120m in longitudinal direction and click OK
This will scale the background image:

Profile

+» 38.54 $ 25.982 Y 34° o 46.48

Scaled background image
» Save the design as ContainerShip_Image.msd
Now we can do this in Plan view as well:

> Repeat the steps above but now in Plan view window with the
image file Containership Image - Plan.jpg. The zero point is of
course on the Centreline and at Aft extremity.

Once you have completed that, you can also import the Containership Image -
Body.jpg.
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> Repeat the steps above, but now in Body Plan view. You will need
to specify a Reference point. The Maximum Beam for the lines plan
is 20m. Therefore for the reference point of the maximum beam is
10 m from the zero point (on the centreline) in the transverse
direction.

» Save the design

The next step is basically starting a surface fitting process by resizing the start-
model (ContainerShip.msd file in this case) to match the background image size.

» Unlock the Hull surface and resize it to a length = 120, depth =
15.0 m and beam =20 m

» Check your work in the different view windows.
» Save your design.

Now, theoretically, in all view windows you should see the surface model
roughly match up with the background image in overall size (not shape yet). In
any case, what should not happen is that your surface model is smaller than the
background image in for example Profile view but bigger in Plan view. This
means that you have set the zero and reference points of the background image
inaccurately in either (or both) of the view windows.

The next step in the surface fitting process would be to set up a grid that matches
the buttocks, waterlines and sections of the lines plan image. After that, you can
start shaping your surface to match the lines of the image; remembering the
following order:

e Corner control points
e Edge control points

e Internal control points

Importing a Background DXF

A note that is worth including here is that DXF backgrounds work in much the
same way as Image backgrounds except for:

e No need to specify scales or zero point (these are inherited from the CAD
drawing)

e You can only import one DXF background in Maxsurf (instead of one for
each view window). It is therefore recommended to convert your 2D DXF
into a 3D DXF in your CAD application prior to importing.

Importing dxf Marker Data & Generating a TriMesh model Tutorial

» First read the Generating a TriMesh Surface section in the
Maxsurf manual.

If the Maxsurf model is required for the purposes of analysis, for example
Hydrostatic analysis in Hydromax and NOT for production purposes then the
Maxsurf model can be simply generated as a TriMesh surface

A TriMesh surface is a linear surface made up of triangular facets, it is not
designed to be smooth — it follows the input data points exactly and is linear
between the data points. The TriMesh surface is designed to be used where an
approximation to the vessel is required with sufficient accuracy for hydrostatics
to be calculated. It is NOT designed to be a smooth surface model from which
the vessel could be built.

155



Importing dxf Marker Data & Generating a TriMesh model - Procedures

Start

In this section we will again start from scratch. If you have an existing design
open, you will have to close it first.

» Select File | New Design.

It is important to set the units in Maxsurf to be the same as the units of the dxf.
For this example the dxf is in mm.

» Select Data | Units
> Set units to mm

It is recommended to Set the Zero point and frame as per the original lines plan.
For this example set the frame of reference up as follows;

» Select Data | Frame of Reference
> Set the Zero Point to be at the aft extent and the baseline

> Set the Aft perpendicular & Fwd perpendicular to be at 1000mm
27720mm respectively.

> Set the DWL to be at 1500mm

Frame of Reference and Zero point @

Longitudinal Datum Vertical Datum

 AftPerp. {1000 mm " DwL 1500 mm

" Midships  |14360 mm @ Baseline |0 mm Firid B
" Fwd Perp. |27720 mm tic " Other 0 mm

G ober [omm 4

Cancel
A

Zero point and Frame of reference

Now import the dxf as markers
» Select File | Import | Dxf Markers

> Select the ‘Import dxf Markers-Generate TriMesh-Supply Boat
example.dxf’ file

You will then be asked to specify the units and the orientation of the markers.
This will be the same orientation used in the dxf program, for this example
Forward is +ve Z, Starboard is -ve X and Up is +ve Y. As follows
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Import Options [z]

o -DK
Import Configurations: Import parameters for DXF File..
Default - Multiframe: * sve
Forward: CRXCY &2z
 ve ~ Units:
- © mm
Starboard: eE ROz Coem
® e
" meties
- " feet
Up: = e i ol © inches
ve

1~ DXF Import Options —

Arc Segment Length:  {2.000
Default - Maxsurf - /GES Import Dptios
I Reverse ) Ordeti A

Add Delete IS

Dxf Import Options

You can now view the imported markers in Maxsurf. Look at the Markers in all
the views to check that you have brought the markers in using the correct
orientation.

[ Maxsurf Professional - [Perspective] FEX)
File Edit View Markers Controls Curves Surfaces Display Data Window Help -8 X
DEE s 2R&8| 2. eas@dt. ne.BEvpwEsEs8(a)x. 0 @5 5.

SR LR AR T, Zlo o iy % CiL Trimming ~ Precision = _

HEErm=malr. SoeB =

OV|dApg.
| Assembly 2x [
E Design

|Properties 2x

) By ovan | @

w
Object Snap: ON

Dxf markers in Maxsurf (perspective view)

Before you can generate a TriMesh from the Markers it is first necessary to order
the markers. It is essential that the markers are grouped by section and that, on
each section, the markers are ordered in a consistent manner.

The Imported Markers represent the sections. The stations share the same
longitudinal properties. The Generate Grid from Markers command can be used
to automatically generate the grid of sections (as well as buttocks and waterlines)
based on the marker data and also associate markers with the correct marker
station index. For more information read the Generate Grid from Markers section
in the Maxsurf User manual.

» Select Markers | Generate Grid from Markers

» Set the generate stations up as follows and click OK:
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Generate Grid from Markers

Generate stations from marker planes

@ Delete existing stations

(O add to existing stations

Minimurm number of markers for a station l?‘]

[[]Generate buttocks from marker planes

g buttocks
of markers for a buttock o ]

[[] Generate waterlines from marker planes

Minimum numl

Minimurn number of markers For a waterline | = ‘
Marker plane separation tolerance | 1 mm

Generate Grid from Markers

In Profile view you can see that the section grid spacing has been set up as per the marker data

Now that the Markers have been assigned to the same Station Index they can
now be sorted for each station.

» Select Markers | Sort Marker stations
To view the connectivity (and ordering) of the markers

P
H
st

>  Select Display | Connect Marker Station: (Ctrl+J,)
This is best done in the Body Plan view with current Station option selected

> Go to the Body Plan view

> Select Display | Markers for Current Station option selected (I*“
You will notice that the first marker on the section is shown in bold

Maxsurf Professional - [Body Plan]

).

Touge dspilay of Trimesh surface.

Connected Markers in Body plan view, note the first marker on each section is shown in bold

Using the station control box in the top right corner and the cursor keys ‘walk’
through the sections to check that they have formed correctly and that the first
(bold marker) is always at the keel.
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The automatic Marker sorting uses a nearest neighbour sort, which works in
most instances, but can be confounded if the section shape is complex and/or the

spacing between markers varies significantly. For example if you section looks
like this;

o L L] 1 A0S WS

TR Gbjec St G

Connected Markers in Body plan view — Markers sorted incorrectly

Then the Markers have not been sorted correctly and will need to be reordered.

For more information on sorting Markers see the sorting Markers section of the
Maxsurf User manual.

To see all the connected markers look at the perspective view.

» Go to the Perspective view window

X%
> Select the show all markers icon ”‘—"1 and the Connect Marker

P
i
waatd”

Stations icon

-
Object Seap: ON

Connected Markers in Perspective view, note the first marker on each section is shown in bold

It is also recommend to use the Delete duplicate Markers function. In most cases
duplicate markers cause problems. This function will delete any duplicate

markers within a specified spacing of each other from a selected group of
markers.

> Select all the markers

» Select Markers | Delete duplicate markers
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> Set the tolerance to 1mm and click OK
Now with the markers all organised we can now generate the TriMesh surface.
» Select Markers | Generate TriMesh Surface for Markers

Generate TriMesh @

[V Mirror surface about centreline.
This is required if the markers only
define one half of the hull,

-Delete abnormally large triangles: -

I Triangles with an edge longer than

[ Triangles with an edge more than I 3

standard deviations greater than the average
edge length will be removed from the mesh.

[V Delete triangles that lie entirely on the centreline.

OK l Cancel |

TriMesh surface dialog
> Leave the default options & Click OK. |

For more information on the Generate TriMesh options see the Generating a
TriMesh Surface section in the Maxsurf User manual.

TriMesh surface can be hidden or made visible using the show TriMesh

command 4] .

To View the rendered TriMesh surface go to perspective view and turn on the
rendering;

Maxsurf Professional - [Perspective]

Fle Edt View Markers Controls Curves Surfaces Display Data Window Help & x

Dl iR 2. aqasadh. o BEFEsR 8 o8 (&) 53 4]0 (@) 2 @ .
LR m | £ W T P R RS = ing ~ Precision ~ _
[@lv|« » »¢ EBE=EE =2 la, B >
2 x
[

Assembly
53 Desi

Properties. 2 x

B

| B B avaw ] EY
Ready

Rendered TriMesh surface in perspective view

As for NURB surfaces you can display all regular contours on a TriMesh
surface. The TriMesh surface can be easily deleted and re-generated using the
options in the Markers menu.

The accuracy of TriMesh surface is purely dependant on the Marker
data, so if you require a more accurate model then you will need
more Marker data.
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The picture below gives some idea of the types of vessels that can be generated
with a TriMesh surface:

Other TriMesh examples can be found in C:\Program Files\Maxsurf 14\Training
Samples\Trimesh Samples

The TriMesh surface model can be saved in Maxsurf as normal (.msd file) and
read directly into Hydromax, Seakeeper and Hullspeed for analysis.

For modelling complex tanks and compartments in Hydromax additional NURB
internal structure surfaces can be defined with the TriMesh model in Maxsurf.

Fitting a NURB Surface to Marker Data Tutorial

If the Maxsurf model is required for production purposes then the Maxsurf
model will need to be created from a faired NURB surface.

Maxsurf has a number of options available to help create a NURB surface model
from marker data.
» First read the Surface Fitting section in the Maxsurf manual.

Fitting surfaces to Marker data is an iterative process. The following simple
example shows the fitting of the default yacht surface to marker data and
highlights the basic procedures.

Fitting a NURB Surface to Marker Data - Video

# This video illustrates the basic procedure for fitting a NURB surface to
Marker data. [Web | Disk]

Fitting a NURB Surface to Marker Data - Procedures

Start

In this section we will again start from scratch. If you have an existing design
open, you will have to close it first.

» Select File | New Design
»  Set units to meters Data | Units
Now open the Marker data
> Go to the Marker window | File | Open Markers
> Select the ‘Yacht Markers - Surface fitting to markers.txt’ file

If you go to the perspective view window you will see that marker data in
Maxsurf. Now import a surface to fit to the marker data, for this example we will
use the Simple yacht surface

» Go to the Perspective view window
» Select Surfaces | Add surface | Simple Yacht
The simple yacht surface can now be manipulated to fit the marker data.
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Firstly we will approximately size the simple yacht surfaces and then move it to
an appropriate location.

» Select Surfaces | Size surfaces

» Select the simple yacht surface and size to length 10m, Beam 3.5m
& Depth 1.5m.

> Now move the simple yacht surface so the transom of the surface
lines up with the Markers for the transom.

A quick way to do this is by turning on the snap settings (F5), selecting all the
surface control points then moving the control point at the base of the transom
and then drag it to the marker at the base of the transom.

Lower transom control point align with lower transom marker in Perspective View

The simple yacht surface control point net contains 3 rows and 4 columns of
control points. We will need to add more rows and columns to the surface
control point net to get the required shape.

» Go to the profile view and add 3 more columns; one aft, one in the
middle and one near the bow.

> Space the columns evenly along the length of the hull.

Add extra columns in Profile View

» Now Go to the body plan view and add 2 Rows; one along the
bottom and one up the side of the control point grid

Your model should now look something like this:
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Marker Data & Simple Yacht NURB surface in Perspective View

It now it is time to do a manual fit of the surfaces to the marker data. The order
in which you should fit a surface to markers is strictly from top to bottom:

e Corner control points
e Edge control points

e Internal control points
So we will start by moving the corner control points. This can be done by either
using the snap control point to marker function or by simply dragging the control
point to the marker with the drawing shap settings turned on.

» Select the transom top corner Marker
»  Whilst holding down the shift key (to select multiple objects)
> Select the transom top corner control point

> Select Markers | Snap control point to marker =

Control points at the Transom

» Now do the same for the top and bottom corner control points at
the bow.
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Control points at the bow

Once the surface corner control points have been moved to the correct location
we can now fit the surface edges to the Marker data using the ‘Fit edge to
markers’ command.

Starting at the bow:

» Select the Markers that make up the bow stem, (hold down the
shift key to select multiple objects)

» Select the surface edge to be fitted to the markers

x

. L
> Select Markers | Fit edge to markers *

o [Matbars | Cortrok  Curves Sufces Disgley Data  Window  Help

Plstle)

Fit bow edge to Markers

> Select ‘Yes’ to leave to leaving the edge corner points where they
are.

» Select Sort by vertical position.
You will see that the surface edge is now fitted to the markers.

» Now follow the same procedure for edge that makes the transom,
the deck and the hull bottom (as per the example video).

By switching views as well as locking the surfaces will make it
easier to select the markers points and the surface edges. The
surfaces will then need to be unlocked again prior to fitting the edge
to the markers.

> Now using the same procedure fit the surface bottom (or keel)
edge to the Markers.
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Fit bottom edge to Markers

» Now fit the surface top (or deck) edge to the Markers.

Fit deck edge to Markers

You will notice that the interior control points, displayed by turning on the
surface net, may be very irregular. The Smooth surface interior command can be
used to smooth the surface's interior control points to follow the shape defined by
the surface's edges. This will give you a much better starting point for faring

> Select Markers | Smooth interior Controls

Your model should now look something like this:

Surface control point net after smooth interior controls
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As mentioned in the chapter on Basic Fairing a_Fair Net Equals Fair Surface, It is
helpful if the rows and columns are near orthogonal and it is especially beneficial
to try to keep the columns as vertical as possible since this makes manipulation
in the body plan view much simple. However, tiding up the control point net will
mean moving the surface edge control points, when doing this make sure that the
surface edge doesn’t deviate too far from that marker data. Note that fitting a
surface to markets is an iterative process.

» InPlan and Profile views go through and tidy up the control point
net.

You model should now look something like this:

Plan view showing control point net

Now that the surface corner and edge control points are in the correct location
and you are happy with the surface control point net. It is now time to move the
internal control points to fit the surface to Marker data. This can be done
manually or automatically using genetic algorithm surface fit function enabled
by Prefit.

Prefit is a program that automatically fits surface to Marker data. It can be used
as a stand alone application or as a plug-in to Maxsurf so you can take advantage
of the tools in Maxsurf and Prefit to fit a surface to Marker data.

To manually fit the surface to Marker data you will need to set up a design grid
that matches the Marker data. This can be quickly done by using the generate
design grid from markers command.

»  Select Markers | Generate design grid from Markers
> Set the minimum number of markers for stations to 3

» Setthe Marker plane separation tolerance to 0.001m & click ok
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Generate Grid from Markers @

Generate stations from marker planes

() Delete existing stations

(O add to existing stations

Minimum number of markers for a station m

[[] Generate buttacks From marker planes

Delete existing buttocks

ting buttocks

Minimum number of markers for a buttock 0 ‘

Add ko exisl

[[] Generate waterlines from marker planes

Minimum number of markers for a waterline | -

Marker plane separation tolerance | 0.001 m

[ OK ] [ Cancel ]

Generate design grid from Markers dialog

> Select the Profile view

> Turn on the design grid lﬁl

» Check that the grid sections line up with the Marker data

Check that the grid sections line up with the Marker data

Now the control points will be manually moved to make the surface section
curves fit to the marker data. The best way to do this is in the body plan view and
using the net control box go through each control point column and manipulate
the control points so that the sections fit the Marker data.

» Select the Body Plan view
> Turn off the sections "=

]

> Turn off the Control point net :*+

> Select show markers for current station
» Select the first control point net column using the net control box

» Move the control points so that the surface section curve fits the
marker data at that section.

> Repeat the process for the next control point net column
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Body Plan view - move control points so the surface section curve fits the marker data at that section

You will notice that moving the internal control points at one station effects the
whole surface, hence it will effect the shape of the surface section curve at
another station. The process of fitting the sections to the Markers is an iterative
process; you will need to go through the control point columns a few times in
body plan view whilst also checking the model in the other views to manual fit
the whole surface to the markers.

When fitting the surface to Markers as the same rules apply to Fairing a
hullform, for more information see the chapter on_Basic Fairing.

When you have finished fitting the surface to the Markers your model should
look something like this:

Perspective view with surface fitted to marker data

Continue with the section on Data Export.
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Data Export

Once you have created a NURB surface model there are many different data
output options depending on the type of task you need to carry out. For example
in case you wish to create a lines plan in CAD drafting package like AutoCAD
you can export DXF lines. If you wish to continue modelling in another NURB
surface modeller you can use the IGES export option.

In case you wish to analyse this design in the other modules of the Maxsurf suite,
you can simply save it in the Maxsurf file format (.msd) and load it in to, for
example, Hydromax. This allows you to make changes to the hull model and
quickly update your Hydromax model without the need for an intermediate data
exchange file.

» Read the section on Data Output from the Maxsurf manual.

Congratulations! You have finished the LearningMaxsurf training.

If you wish to uninstall the LearningMaxsurf installer, use Control Panel | Add or
Remove software and select LearningMaxsurf.
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